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1. OpenRoads Designer Basics 
OpenRoads technologies are integrated with ProjectWise. As such, the ProjectWise Managed 
Workspace delivers OpenRoads configurations and template files within the managed ProjectWise 
environment.  Throughout this document, specific functionality of OpenRoads with ProjectWise will be 
called out and expanded on in a workflow specific manner. 

1.1 OpenRoads Designer vs. InRoads:  What is the Difference? 

It is important to distinguish the differences between the current OpenRoads Designer environment and 
the InRoads environment that has existed up to this point.  This document will try to highlight some of 
these differences, but the following items will shed some light on the specifics. 

InRoads and Native Tools – These are the tools and file formats that would be recognizable from the 
SS2, SS4, and SS10 versions of InRoads.  Native tools are those that are located on the InRoads Explorer, 
so items like Annotations, Plan and Profile Generator, and the like.  These references may also include 
the old file formats such as ALGs, DTMs, etc. 

OpenRoads and OpenRoads Technologies – While working with the OpenRoads Designer application, 
there is no need for a separate application such as InRoads to create alignments (ALG’s), terrains 
(DTM’s), sheets, etc.  OpenRoads Designer is designed to handle all aspects of roadway modeling and 
plan sheet creation in one application.  For INDOT purposes, the major areas where this functionality 
will be used are items such as OpenRoads Survey, Terrains, Civil Geometry, Corridor Modeling, and Cross 
Sections—features that are not found in the old InRoads toolset. 

1.2 The OpenRoads Designer UI 

The following sections will review the specific interface Workflows and Project Explorer items that you 
can expect to see when working with OpenRoads Designer.  Note that most of these are OpenRoads 
specific and will not be available in other MicroStation Platform products.  

1.2-1  OpenRoads Designer Workflows 
For a more in-depth discussion of the MicroStation Platform interface, and additional information on 
interacting with workflows, please refer to the INDOTWise 5.1 MicroStation module. 

This subsection will cover each of the workflows in OpenRoads Designer, along with a brief description 
of their purpose.  Before doing so, it should be noted that each workflow—with the exception of the 
SignCAD workflow—has a Home tab that has commonly used tools/functionality such as the assignment 
of attributes, reference attachment, model display, element selection, etc. 

 
Home Tab 
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1.2-1a OpenRoads Modeling Workflow 
The OpenRoads Modeling workflow is designed to guide the user in modeling various design elements 
such as terrain, geometry, parcels, corridors, etc.  Each of these design elements has its own specific tab 
in the workflow. 

 
OpenRoads Modeling Workflow 

The Drawing Production, Drawing, and View tabs are more specific towards the production of 
drawings—which will be covered next in the discussion of the OpenRoads Drawing Production workflow. 

1.2-1b OpenRoads Drawing Production Workflow 
The OpenRoads Drawing Production workflow contains three workflow-specific tabs: 

• Drawing Production: Used to place text, annotations, create named boundaries that are used to 
cut sheets, set the drawing scale, etc. 

• Drawing: Used for general drafting work on a drawing. 
• View: Used to manipulate the display of the current view. 

 
OpenRoads Drawing Production Workflow 

1.2-1c Survey Workflow 
The Survey workflow contains tools that are specifically geared towards generating survey data such as 
field books, terrain, survey annotations, etc. 

 
Survey Workflow 



 8 

1.2-1d Geotechnical Workflow 
The Geotechnical workflow is designed to assist with adding geotechnical information to a design 
model. 

 
Geotechnical Workflow 

1.2-1e Reality Modeling Workflow 
The Reality Modeling Workflow provides tools to enhance the design model with various effects such as 
reality meshes and models, raster images, and point clouds. 

 
Reality Modeling Workflow 

1.2-1f Drawing Workflow 
The Drawing workflow provides tools to draw elements in a model, annotate a model, measure specific 
elements, among many other tools. 

 
Drawing Workflow 
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1.2-1g Modeling Workflow 
Only visible in 3D models/files, the Modeling workflow provides tools to create and/or modify various 
3D elements. 

 

Modeling Workflow 

1.2-1h Visualization Workflow 
Only visible in 3D models/files, the Visualization workflow allows you to create animations for your 
design content. 

 

Visualization Workflow 

1.2-1i OpenRoads SignCAD Workflow 
The OpenRoads SignCAD workflow—if enabled for an individual user—provides tools to import and 
paste sign files (.sgn) directly from the OpenRoads SignCAD sign libraries.  Of particular interest for this 
purpose is the SignCAD tab in this workflow. 

 
OpenRoads SignCAD Workflow 
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1.2-1j Drainage and Utilities Workflow 
The Drainage and Utilities workflow contains tools to create and place various drainage and utility-
related elements to a design model. 

 
Drainage and Utilities Workflow 

1.2-1k INDOT Tools Workflow 
The INDOT Tools workflow contains INDOT-specific tools that are specific to the workspace.  From this 
workflow, users can launch the AutoTurn application, add title block integration, connect to INDOT cell 
libraries, among many other tasks. 

 
INDOT Tools Workflow 

There are a few dropdown menus in this workflow to pay attention to.  The first is the Signs Cells 
dropdown on the Cells tab—which provides a connection to each of the traffic sign cell libraries. 

 
Signs Cells Dropdown Menu 

The other two are the Letter Size and Full Size dropdown menus on the Annotation Tools tab—which 
provide specific annotation styles for Letter Size and Full Size Sheets respectively. 
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Letter Size and Full Size Dropdown Menus 

1.2-2  Project Explorer 
The Project Explorer interface allows you to browse and manage content within an OpenRoads Designer 
file. 

 
Project Explorer (docked on left side of user interface) 

Note: If the Project Explorer interface does not display automatically upon opening OpenRoads Designer, 
you can open it manually by navigating to the Primary button group in most workflows, which should 
contain an Explorer button to launch Project Explorer.  Once opened, you can then dock it on the 
interface as desired. 

The remainder of this section will give a brief overview of the different tabs in Project Explorer. 
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1.2-2a OpenRoads Model Tab 
The OpenRoads Model tab displays information on any modeling components (alignments, terrains, 
corridors, templates, etc.) that are contained within the file. 

 
OpenRoads Model Tab 
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1.2-2b OpenRoads Standards Tab 
The OpenRoads Standards tab shows the various CAD standards that have been applied within your 
active design file.  It also allows you to see the components of the various standards libraries that have 
been implemented into the workspace. 

 
OpenRoads Standards Tab 

1.2-2c Drainage and Utilities Model Tab 
The Drainage and Utilities model tab lists all the drainage and utility-related elements that have been 
added to the file via the Drainage and Utilities workflow. 

 
Drainage and Utilities Model Tab 
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1.2-2d Survey Tab 
The Survey tab shows all the survey data that has been imported into the file.  It lists the name of the 
fieldbook that was created, the data file it was created from, and all the features, control points, setups, 
and observations that are associated with the survey data.  More information on how to import survey 
data into an OpenRoads Designer file is covered in Chapter 6. 

 
Survey Tab 
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1.2-3  The View Control Right Click Menu 
The View Control Menu in OpenRoads Designer allows the user to view a design from many different 
perspectives.  From this menu, users can open a new view to view designs in 3D, in cross section view, in 
profile view, along with various other view commands such as quickly toggling the view presentation, 
toggling construction elements, and various zoom and rotation commands.  To access this menu, simply 
click and hold the right mouse button in the active view.  Then hover over the arrow in the View Control 
field in the menu that appears to access the view options. 

 
View Control Menu 

As you can see, there are several options to choose from.  To illustrate an example, here is what 
happens to the display when the 2 Views Plan/3D option is selected when you only have a plan view 
currently displayed: 
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2 Views Plan/3D 

As you can see, ORD splits the display into the standard 2D plan view and a 3D view.  For future 
reference, this is the view display that is necessary to create cut cross sections from, as you need to 
have a 3D view open and active to perform the operation. 

To illustrate another example, here is what happens with the 2 Views Plan/XS option.  Note that upon 
selecting this option, you will first be prompted to create a dynamic cross section view.  Click OK at the 
prompt to proceed.  A new view will be opened. 

 
Create a Dynamic Cross Section View 

You will then be prompted to locate your corridor or alignment to view cross sections along.  Select your 
corridor or alignment. 
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Selecting Corridor or Alignment 

Finally, you will be prompted to select/open a view to place the dynamic cross section view in.  In this 
example, select the view that was automatically opened. 

Then click in the open view to place the dynamic cross section viewer.  Your views will then be tiled to 
show both views and their respective content. 

 
2 Views Plan/XS 
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Note that the cross-section view being displayed is dynamic, where you can adjust the stationing as 
necessary to display the cross sections along a corridor or alignment. 

The final example is the 2 Views Plan/Profile option.  As its name implies, it will place a profile view in 
conjunction with the plan view.  Note that you upon selecting this option, you will first be prompted to 
create a dynamic profile view.  Click OK to proceed.  A new view will be opened. 

 
Create Dynamic Profile View 

You will then be prompted to select your horizontal alignment (or “Plan Element” as it is referred to in 
the prompt). 

 
Selecting Horizontal Alignment 

Once the horizontal alignment is selected, you will be prompted to select an open view to place the 
profile viewer into.  In this example, the newly opened view will be selected.  Then click inside the new 
view to place the profile display. 

 
2 Views Plan/Profile 
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The remainder of the options pertaining to the number of views to display are variations of these 
examples that have been shown.  The rest of the options in the menu after that are self-explanatory and 
perform the function listed. 

1.3 OpenRoads Designer Standards and Seed Files 

This section will discuss the location of INDOT-specific OpenRoads Designer standards and seed files for 
use with the application.  All OpenRoads Designer files except DGN seed files will be found under folders 
within the following ProjectWise path: Documents\Template Documents\ORD-Connect Seed.  It is highly 
advised that users do not interact directly with files under this location as the underlying OpenRoads 
technology requires that the workspace maintains a high degree of integration. 

1.3-1  ITL File 
As of the release of the InRoads/OpenRoads SS4 workspace, a customized agency template library has 
been created and is now available.  It contains several default templates configured with agency specific 
feature, component, and point naming.  It also contains the relevant templates used by the agency civil 
cells. 

These templates can be found under the Template Library folder, in the INDOT.itl file.  Like the XIN file 
that was used with InRoads, this library is automatically attached at startup. 

1.3-2  Civil Cells 
With the migration to InRoads SS4 and OpenRoads technology, the workspace now contains several Civil 
Cells.  These can be found under the Civil Cells folder and are attached automatically at startup.  Note 
that these are DGNLib files, and direct customization will not be available. 

1.3-3  Cell Libraries 
All INDOT cells for use with OpenRoads Designer can be found under the Cell folder.  There are several 
cell libraries in use under this folder: 

• IN_InRoads.cel 
• IN_MOTCells.cel 
• IN_PE-LS-Stamps.cel 
• IN_Signs_Construction.cel 
• IN_Signs_Guide.cel 
• IN_Signs_Recreational.cel 
• IN_Signs_Regulatory.cel 
• IN_Signs_School-ObjectMarkers.cel 
• IN_Signs_Warning.cel 

The first library is used by the Aerial Survey group for topographical collection.  The second library is 
used for the display of point features in the topographical surface and other items such as cells placed 
for title sheet integration and north arrows.  The third library contains cells that are specific to denoting 
Maintenance of Traffic (MOT) operations on plan sheets.  The fourth library contains cells with digital 
versions of Professional Engineer and Land Surveyor stamps.  The remaining libraries contain traffic sign 
cells, categorized by sign type.  

pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5C_Resources%5CClientWorkspaces%5CINDOT%5CINDOT_OpenRoads%5COrganization-Civil%5CINDOT%5CTemplate%20Library%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5C_Resources%5CClientWorkspaces%5CINDOT%5CINDOT_OpenRoads%5COrganization-Civil%5CINDOT%5CTemplate%20Library%5CINDOT.ITL
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5C_Resources%5CClientWorkspaces%5CINDOT%5CINDOT_OpenRoads%5COrganization-Civil%5CINDOT%5CDgnlib%5CCivil%20Cells%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5C_Resources%5CClientWorkspaces%5CINDOT%5CINDOT_OpenRoads%5COrganization-Civil%5CINDOT%5CCell%5C
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1.3-4  Plans Production – Sheet Borders 
The files located under Sheet Borders are used in the creation of all plan sheets.  Discussion of these files 
will be expanded with their usage in the Plans Production workflow. 

1.3-5  OpenRoads Designer DGN Seed Files and the Importance of File Associations 
OpenRoads Designer allows for any DGN or model in a DGN to be a container for OpenRoads elements 
at any time.  As such, the first item required when starting an OpenRoads Designer project is the 
appropriate unit DGN seed file.  For all new projects that are created after the Fall 2013 release of the 
Indiana Design Manual Part 1 (Ch. 106, Section 26-1.01 memo requiring Geo-Coordinated seed files), 
you will be provided a Survey seed file in the pw:\\indot-pw.bentley.com:indot-pw-01 
\Documents\District\Des No.\ Survey\Project Files folder of your project with the following naming 
convention: Des #_SRxx Seed 2D.dgn and Des #_SRxx Seed 3D.dgn.  These seed files are used to set the 
coordinate system for every OpenRoads Designer-based file in your project.  Each will already have the 
properly selected working units for your project.  If you are a consultant working on an INDOT project 
and do not have access to the Survey\Project Files folder, please contact your surveyor to request the 
newly required geo-coordinated seed files. 

Your project might fall outside the requirement window of the new design memo, so you may continue 
to use the previous method of creating your own seed file (or possibly ask the Surveyor if they can 
create one for you).  The files you will need are located with the rest of the INDOT-specific ProjectWise 
seed files.  They can be found at pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template 
Documents\ORD-Connect Seed\.  

At the root of this location, 2 seed files have been provided, corresponding to the units of measurement 
used in current INDOT projects.  These are: 

• INDOT_US_SVFT_3Dseed.dgn 
• INDOT_US_SVFT_2Dseed.dgn 

Please note that both 2D and 3D versions of each file have been made available.  OpenRoads technology 
allows for the full use of civil data regardless of the availability of the Z axis.  For instance, when showing 
3D OpenRoads elements in a 2D seed file, a 3D model will automatically be created as needed.  
Throughout the remaining chapters, care should be given to what seed file a particular function would 
best function in.  For example, if working with survey and terrains, users need to utilize 3D seed files.  
Also, if working with corridor modeling, users should be utilizing 2D seed files. 

These files are configured with Design History disabled to remove compatibility errors caused by the 
rapid display and deletion of elements during the design process. 

Finally, as OpenRoads Designer is integrated with ProjectWise, these seeds are configured with their 
application association set to OpenRoads Designer, causing OpenRoads Designer to launch when the 
files are checked out and opened. 

  

pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CINDOT%20Workspace%5C_Resources%5CClientWorkspaces%5CINDOT%5CINDOT_OpenRoads%5COrganization-Civil%5CINDOT%5CSheet%20Borders%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CINDOT_US_SVFT_3Dseed.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CINDOT_US_SVFT_2Dseed.dgn
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1.3-6  ProjectWise 
1.3-6a Project Creation 

The first step in working with OpenRoads Designer and ProjectWise is the creation of your project.  At 
this time, the Design project template has been setup to have distinct OpenRoads Designer folders 
separate your data.  As always, if your project does not yet have a Design folder, please create the 
project/folder using the DOTWise Project Creator. 

1.3-6b Survey Provided Files 
When starting an OpenRoads Designer project, you can expect having access to the following files: 

FOR ORD PROJECTS 

1. Des #_SRxx Survey Fieldbook.dgn - Contains Fieldbook information for TOPO and Control Points 
in the OpenRoads Format (survey fieldbook) along with the existing terrain model.  This will be 
done in a 3D model. 

2. Des #_SRxx Survey Alignment.dgn - Contains Survey alignment(s) in the OpenRoads Format (civil 
data – linear elements).  This will be done in a 2D model. 

3. Des #_SRxx LCRS Plat.dgn - MicroStation plat DGN 
 
To begin a project, it is recommended to copy the Alignment and Terrain DGNs that Survey provides into 
your Design\OpenRoads Designer folder in ProjectWise.  These are the base files you will start your 
project from and should be available in a read-write location as you will be directly interacting with 
them. 

With these files copied into your project, it is suggested to rename the DGN containing the survey 
alignment to Des #_SRxx Design Alignment.dgn.  This will alleviate confusion and specifically denote that 
this file is for the proposed alignments while maintaining the collected information from the Survey 
alignment. 

1.3-6c Base Drawing Creation 
To start creating a project, the only item required is a base DGN to start the product with.  Using the 
advanced document creation wizard, you can create your base drawings using the unit appropriate seed 
file as noted in Section 1.3-5.  The INDOT base drawing naming convention will still be used. 

Project information will be organized into several base drawings.  The information is separated based on 
categories of information included.  These base drawings are the locations for all line work.  Most base 
drawings will be created while in OpenRoads Designer.  By using OpenRoads-based referencing tools, a 
base drawing can be enhanced to view other base drawing information as a backdrop.  Please refer to 
the INDOT Wise MicroStation module for a summary of base drawings and recommended naming.  
Below is a list of Standard Base Drawings to be used at INDOT and descriptions of their contents. Other 
names are possible based on project needs. 
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Standard Base Drawings 
Drawing Names / 
Logical Names 

Descriptions / 
Reference Descriptions 

Examples 

Survey Alignment Survey Centerline Des #_SRxx Survey Alignment.dgn   
Survey Section 
Corner 

US Government Section Corners Des #_SRxx Survey Section 
Corner.dgn 

Survey Fieldbook Survey Existing Topography and 
Contours 

Des #_SRxx Survey Fieldbook.dgn 

Prplan  Proposed Design Strings Prplan.dgn 
RW Existing scale Existing Right of Way RW Existing.dgn 
Design Alignments Design Alignments Design Alignments.dgn 

 

If your project is anticipated to require multiple scales, it may be desirable to create multiple base 
drawings at those scales.  Creating the multiple scaled drawings is easily done by creating a new plan 
display titled appropriately for the scale to be created, and then displaying the appropriate models at 
the desired scale.  Some examples of scales and various usages are presented below. 

Using this procedure makes it extremely easy to vary the scale of a sheet by simply picking the base 
drawings that have the desired scaling when referencing into the OpenRoads Designer drawings.  From 
this point forward, the 1” = 30’ scale will primarily be used in this documentation.  Note that the scale 
will vary with projects, and other scales can be developed using the same procedures as described. 

US Scales 

Scale Typical Uses 
1” = 20’ Construction details and other detail drawings.  
1” = 30’ Bridge Layouts and Constuction Details and Plan profiles 
1” = 50’ Most common scale used in plan and profile sheets and 

plan drawings. 
1” = 100’ Pavement marking plans, and other miscellaneous 

sheets. Pavement markings are unreadable at this scale. 
 
Note:  OpenRoads technologies make substantive use of the Annotation Scaling tools for element and 
feature display.  When discussing multiple scaled base drawings, it may be beneficial to create a single 
base drawing and then scale the content through using the scaling settings available on reference files. 

1.4 Opening, Closing and Saving OpenRoads Files from ProjectWise 

With the integration of OpenRoads Designer and ProjectWise, procedures for opening, closing, and 
saving files in OpenRoads Designer differs from these functions as shown in training.  As with 
MicroStation and other integrated applications, standard Open and Save dialogs are replaced with 
ProjectWise integrated dialogs with extended functionality.  Please keep in mind that these options will 
be used when working with the legacy file formats of the InRoads software. 
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1.4-1  Opening Existing Files 
Note: In most cases, OpenRoads files will be opened directly from the ProjectWise Explorer.  The 
following method can be used when switching between files, but it should be noted that doing so could 
result in being prompted to reload the workspace/application. 

To open a file from within OpenRoads Designer, first click on the File tab.   

 
File tab 

Then on the File menu, the Open command should be automatically selected, and a list of recently 
opened files for the current WorkSet will then appear.  If the desired file to open is in the list, clicking on 
it will open it.  If the desired file is not in the list, click the Browse button to open the Open dialog: 

  
Opening ProjectWise-Based Files from OpenRoads Designer 

If you wish to narrow down the list of files by application, that application can be selected from the 
Application field—which contains a list of applications that have been defined in the ProjectWise 
environment. 
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Additionally, you may selectively open a file in a read only mode by selecting it in the Open dialog and 
enabling the check box for open it as read only: 

 
Adding Files to an Open list/Read Only 

1.4-1a Workspace/Workset Association Warning 
In OpenRoads Designer, users will find that all files have the workspace/workset definition for their 
project burned into the DGN as it is used.  With the myriad of external firms that INDOT works with, it 
will be very common to find files that are associated with different workspaces/worksets than what is 
made available in the ProjectWise Managed Workspace.   

The following warning will be common if you’re starting with files that were created using a version of 
our external workspace, or another firm’s modification of the workspace made available publicly.  Most 
often, this will be seen when starting with survey data provided by an external firm. 

 

This is simply a message indicating that the file is associated with a different workspace and workset 
than what we have configured in ProjectWise and will not prevent you from opening or working with 
the files as you typically would.  If you want to unassociate and reassociate the files from/to the 
ProjectWise workspace, a pair of key-ins are available to perform this action and can be found in the 
linked technote: How to remove the workset association in a dgn file - OpenRoads | OpenSite Wiki - 
OpenRoads | OpenSite - Bentley Communities 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/40405/how-to-remove-the-workset-association-in-a-dgn-file
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/40405/how-to-remove-the-workset-association-in-a-dgn-file
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1.4-2  Saving New Files 
When performing a Save for the first time, or a Save As on an existing file, you will be presented with an 
OpenRoads Designer/ProjectWise specific Select a Wizard dialog, as shown below: 

 
Select a Wizard Dialog 

It is suggested to select the No Wizard option and click OK to bring up the Save Document As dialog: 

 
Save Document As Dialog 

All ProjectWise Save dialogs require you to define your project folder, document name, file name, and 
description.  It is still recommended that you maintain the same naming convention—at least for the 
document and file names.  Also, it is very important to make sure the application is appropriately set to 
the file type you’re attempting to save to, as the dialog does not assume the file type you’re saving. 
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1.4-3  Closing Files 
When closing files from within OpenRoads Designer, the user will be presented with the ProjectWise 
Check In dialog: 

 
ProjectWise Check In Dialog 

It is recommended that each check in be accompanied by good comments to allow quick review of 
anything that may have been done. 
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1.4-4 OpenRoads File Versions and Civil File Manager 
As part of using OpenRoads Designer, all files with civil content have what’s referred to as a civil 
branding applied to it.  This branding is a combination of the civil product in use, along with the version 
of the civil schema that is applied to the DGN file.  The civil schema in particular is very important as part 
of moving a file between versions and is largely where improvement in subsequent versions of each civil 
product are contained. 

1.4-4a Opening Files from a Previous Version 
When first opening a file that originated in an older version of OpenRoads Designer, users can expect a 
prompt similar to the following: 

 
OpenRoads Civil File Upgrade 

The preceding dialog offers a number of things to consider when opening a file in a newer version of 
OpenRoads Designer.  First, it informs you of the original product version that the file was last edited in 
and the version the file is currently being opened in.  The above example illustrates what one can expect 
when opening a file from OpenRoads Designer 21R2 in OpenRoads Designer 2023.  The provided options 
as shown control what ultimately happens with the file from that point.  Selecting Yes will upgrade the 
civil schema of the file to the opening application version—which in this case is OpenRoads Designer 
2023.  Selecting No will open the file read only, and not upgrade the civil schema.  No file modifications 
will be permitted if this option is chosen.  Selecting Cancel will not open the file and close the 
application. 

In most situations, selecting Yes will be advised as files will need their civil schema updated to continue 
working with the data.  Users should validate the file content after performing this upgrade and can free 
the file if any data appears to have not come over cleanly.  In cases such as this, CAD Support should be 
contacted to investigate what may not have been upgraded properly.   
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1.4-4b Opening Files from a Newer Version 
Just as files from an older version behave, OpenRoads Designer can also open files from versions newer 
than what is currently being used in a Read Only fashion for viewing.  When opening files from a newer 
version, one will be prompted with a similar dialog to the one shown: 

 
Newer Civil Data 

In this instance, a file from the 2023 version of OpenRoads Designer was opened with OpenRoads 
Designer 21R2, resulting in the information shown.  Selecting OK will proceed to open the file Read Only 
and allow limited information to be gathered from the civil content.  Selecting Cancel will close the file 
and application. 

This situation is a potential scenario where the file could be downgraded by the Civil File Manager tool in 
the current application platform. 

1.4-4c Civil File Manager 
Both preceding scenarios deal with interacting with files on a one-on-one basis.  Due to the nature of 
recommended file federation and other file organization considerations, there may be benefit to bulk 
upgrading or downgrading of civil content files.  In this section, the Civil File Manager tool will be 
discussed, and example processes will be covered on how to bulk upgrade and downgrade OpenRoads 
Designer files.   

Note: The Civil File Manager tool also performs other functions to civil content files that are outside the 
scope of this document.  For more in-depth information on the covered processes or if the additional 
functionality may be needed, please contact CAD Support to receive assistance specific to the data in 
question. 

Opening the Civil File Manager 
The Civil File Manager can be accessed through two different means.  The first is through the 
OpenRoads UI, and the second through the Windows File Explorer.   
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To open the Civil File Manager through the OpenRoads UI, first open a file in OpenRoads Designer 2023.  
This can be editable or Read Only.  In the Backstage menu, through the File Ribbon, locate Civil Tools on 
the lower left.  Under the Civil Tools, select the Civil File Manager. 

 
Civil Tools > Civil File Manager 

The Civil File Manager can also be launched directly from Windows File Explorer by browsing to 
C:\Program Files\Bentley\OpenRoads Designer 2023.00\OpenRoadsDesigner, and double clicking on the 
CivilFileManager.exe file located in the directory.  Note that the file extension may be hidden. 

 
Civil File Manager in Windows Explorer 

Both methods will launch the Civil File Manager for use. 
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Bulk Upgrading Project Data through Civil File Manager 
With the Civil File Manager open, the following process can be used to bulk upgrade files to a selected 
version of OpenRoads Designer. 

Notes for Using Civil File Manager: 

The Civil File Manager can also be used to force upgrade civil content from InRoads SS4/SS10.  This is 
limited to civil content that is part of the DGN and includes survey fieldbooks, civil geometry, terrains, 
etc.  This tool will not upgrade any InRoads specific files such as ALGs, DTMs, etc.  Care should be 
exercised when performing an upgrade from SS4/SS10 InRoads files, and files should be checked 
extensively to ensure that all content was upgraded properly. 

Consideration should be used for the location of files when performing the Export of files discussed in the 
following process. It may be beneficial to separate ORD content from legacy SS10 content to both 
expedite the process and minimize chances of upgrading files unintentionally. 

To minimize potential errors with the upgrade process, DO NOT attempt to directly perform the upgrade 
process on files directly in ProjectWise.  Any ProjectWise dialogs should be canceled and the use of local 
file/folder paths should be used. 

To upgrade files: 

1. Locate the folder structure in ProjectWise that is a candidate to upgrade.  Right click on the 
folder and select Export. 

 
Export Folder 
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2. For the Export process, the following steps should be followed: 
a. First, the Export will be performed as a managed export where the files can be brought 

back into the system.  Select the Export option on the Folder Export Wizard 

 

Folder Export Wizard – Export Option 

b. Next, find a location on your local computer.  Suggestions would be for something 
similar to C:\temp\ORD Upgrade, or some location that is otherwise easily identifiable.  
As with all other Export suggestions, DO NOT use a location that is automatically 
synched with OneDrive such as Documents or Desktop.  For the process, the following 
should also be enabled/disabled as shown.  Select Next when prepared. 

 

Selecting Export Folder and Settings 
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c. All documents in the ProjectWise folder path will be exported—many of which may be 
unnecessary for the upgrade process.  At this time, one may open the Local Document 
Organizer, select the Exports option, and free the unneeded documents prior to 
proceeding with the upgrade.  The Free option should be used, not the Free – Leave 
Copy as the latter will leave a copy in the exported path and may interfere with the 
upgrade process. 

 

Freeing Unneeded Documents for File Upgrade 

3. Go to the File > Open > …. Menu entry, and select the appropriate option from File, Folder, and 
Folder + sub folders.  Note that the Folder, and Folder + sub folders options will select ALL DGN 
files in the selected paths.   

 
File > Open 

4. Select the file(s) or folders that need upgraded.  The following steps will assume a Folder + 
Subfolders was selected. 
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5. With the folder selected, all DGN files in the path will be listed in the Civil File Manager 
document tree, as shown below.  Be sure to expand out the folder contents. 

 
Civil File Manager Document Tree 

Note: All DGNs in the selected path get added to the Civil File Manager.  For this example, notice that 
there are files showing icons for OpenRoads Designer, V8i, and question marks.  These denote the 
platform the file originated in, and in the case of the question marks, they denote that there is no civil 
schema that can be read in the file.  These files will be ignored during the upgrade process. 

6. Selecting a file from this list will display the contents of the Civil Schema of the file and show 
which application and version the file is aligned with.  The files in this example show OpenRoads 
Designer and a version of 10.10.21.04, denoting the OpenRoads Designer 21R2 version.  Note 
that these applications and versions can be different depending on the last used product and 
version—especially in situations where an external user may be supplying content.  For internal 
project data, one can expect to see OpenRoads Designer or V8i (SELECTSeries 4) depending on 
the file selected. 

 
Civil Schema Information 
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7. With the appropriate content loaded, select View > Upgrade List to switch to the Upgrade view.  
Note that the Document Tree will switch to the Upgrade Group view. 

 
Upgrade List 

8. At this time, select the Action menu and the appropriate process to proceed with.  The options 
are as follows: 

a. Align All – Will set the base product to the current application.  Useful if files branded 
from another application such as OpenBridge or OpenRail are used.  Will not be 
available if the product is not changing. 

b. Upgrade All – Will upgrade the Civil Schema of the files to the current application 
release.  Will not process if the files have missing references. 

c. Upgrade All (Force) -- Will upgrade the Civil Schema of the files to the current 
application release regardless if the files are missing references.  This will be the method 
that is necessary for upgrading files using this process. 

d. Downgrade Civil Model – Will allow for the downgrade of the Civil Schema to a prior 
version, useful if collaborative users may not have the same application version. 

 
Civil File Manager > Actions 

9. For this example, the Upgrade All (Force) will be selected.  The files will then process in the 
background and show a status output and state of the upgrade process.  Upon completion, 
users will be prompted to check the files back in, and if desired, to upload backup copies of the 
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files in the event the upgrade did not process properly.  In this case, the files will be checked 
back in with their backup copies. 

 
Civil File Manager Output 

10. Post upgrade, the Civil File Manager will update and show the Civil Schema and version that the 
files have been upgraded to.  This can be compared to the initial illustration in step 6.  For this 
example, note that those files that were listed as SelectSeries 4 have been upgraded to 
OpenRoads Designer. 

 
Post Upgrade Civil Schema 

11. With the upgrade complete, the Civil File Manager can be closed.  Going back to the Local 
Document Organizer in ProjectWise, select the Exports entry, and then select the appropriate 
files to re-import.  Right click on the selected files and select the Import option. 
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Importing Upgraded Files 

12. When the Import is selected, enter any relevant comments and select OK to begin the Import 
process.  Once imported, files should be checked to ensure that all referencing, civil links 
between federated files, and other relationships between files have been preserved. 

Note: Post upgrade files should open normally with the current version of OpenRoads Designer.  This 
process will also eliminate the file upgrade prompt upon opening.  If there are SS4/SS10 files that are run 
through this process, please keep in mind that they will need to have their application association 
changed to OpenRoads Designer in ProjectWise so the compatible platform opens.  If this is not done, 
files will be limited to Read Only in SS10 as the legacy applications cannot translate the updated civil 
information.  A prompt will be received notifying of this case. 

Downgrading Civil Files 
The previous process can also be used to downgrade files for collaborative users who may not have the 
same version of OpenRoads Designer in use in the agency.  All steps through step 7 in the previous 
section are the same.  To downgrade: 
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1. Select the Action > Downgrade Civil Model option.  A prompt will display warning of data loss.  
Consideration should be given as not all civil content will be available in older versions.  Other 
translational methods may be preferred such as LandXML, etc. to share data backwards. 

 
Downgrade Civil Model Warning 

2. After selecting OK on the warning, the Downgrade Civil Model dialog will display showing the 
source and then the Target Versions that can be accommodated.  Note that not all OpenRoads 
Designer versions may be available.  Of some use however may be the option to remove the 
Civil Model if a file containing only the elements with no civil intelligence is desired.  Select the 
appropriate option and select OK. 

3. When prompted, select where the files should be placed on downgrade.  Note that the 
downgraded files cannot be placed in the same folder as the source files. 

4. The Downgrade process will begin.  It may appear that no activity is occurring initially, as the 
background process is performing file copies to the destination location.  When complete, a 
document downgrade status will be shown, along with a prompt to Check In the files. 

 
Downgrade Civil File 
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Upon completion, downgraded copies of the files will be placed in the selected destination.  A backup 
file is not provided as the source files are not modified during this process.  Again, as with the upgrade 
process, files should be checked to ensure that all necessary content is showing in the downgraded files.  
To do so, open in the current version, but not do upgrade when opening, allow the files to be opened 
Read Only. 

1.5 OpenRoads Technologies 

1.5-1  Using 2D Seed Files/Models for Design 
In a departure from previous versions and guidance, OpenRoads technologies highly emphasize the use 
of 2D models for the design process.  Throughout this document, many instances that previously 
referred to the use of a 3D seed file/model configuration have been amended to reflect this change in 
software philosophy.   

As part of using a 2D seed file, the OpenRoads product will automatically create a 3D model on the fly.  
Bentley advises that when performing operations, all work be done in the 2D model with a view of the 
3D model open so that modifications can be seen as they occur.  This 3D model will only be created once 
a terrain model has been generated or attached and activated. 

A proposed workflow would be to process all survey in a 3D seed file, and then attach this 3D content to 
a 2D seed file for alignment and design purposes. 

1.5-2  Alignment Naming in OpenRoads 
Within the following chapters, in many cases you will see references to how alignments are or should be 
named.  Convention up to this point has been to name these Line ”A”, Line “B”, etc.  However, as of the 
transition to ORD, please be advised that CAD Support strongly recommends that users no longer use 
quotation marks in alignment names.  Continuing to do so can cause instability/crashing behavior in 
plans production processes that cannot process alignments that contain them.  Should you import any 
source data into your design file that contains an alignment name with quotation marks, the first step 
should be to rename the alignment to eliminate the quotation marks. 

1.5-3  OpenRoads and MicroStation Multi-View Configurations 
As discussed in the previous section, OpenRoads Designer will automatically create 3D models when 
started from a 2D seed.  In these instances, and others such as profile creation and dynamic cross 
section review, it may be advantageous or required to open multiple views.  The following steps will 
cover how to open additional views, and then, if necessary, how to display content from a different 
model. 

  



 39 

1. When in OpenRoads Designer, locate the View tab in the current workflow.  Then locate the View 
Groups Group. 

 
View Groups Group 

2. By default, most files will open with view 1 active as your active display.  To open an additional 
display, select one of the other views so the button is depressed. 

 
Second View Opened 

3. At this point, depending on the tool in use or if you are modifying the display, the steps will branch 
off.  If the tool prompts to select an active display to show content (profile creation, dynamic cross 
sections), place a data point in the display as requested.  If wanting to display content from a 
different model, continue on. 

4. With the view open, select the View Attributes button. 

 
View Attributes 
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5. On the View Attributes, expand the View Setup leaf.  Under the Models dropdown, select the 
appropriate -3D model.  These models will name themselves after the base DGN model that the 
terrain is created in. 

 
Selecting 3D Model 

6. At this time, two models would be displayed.  View 1 would presumably have the 2D Default model 
displayed, and the Default-3D model will display in View 2. 

1.5-4  Project Explorer 
In OpenRoads Designer, file types such as DTM, ALG, and FWD are no longer required for many of the 
tools.  Bentley has now made the DGN file the container for much of this data.  To access this data, 
OpenRoads Designer uses the Project Explorer. 

When starting OpenRoads Designer you may need to enable the Project Explorer.  To do so, go to the 
Home tab for the current workflow, and select Explorer from the Primary Group. 

 
Starting the Project Explorer 
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An Explorer tab should then appear on the far left side of the interface. 

 
Explorer Tab 

Hover over the Explorer tab to display the Project Explorer’s contents, and then click on the pin icon to 
pin it to the display. 

 
The Project Explorer in OpenRoads Designer 

1.5-5  Drawing Scale 
OpenRoads Designer leverages the MicroStation-based Drawing Scale Tools.  These tools are in the 
Drawing Scales Group at several locations throughout all of the workflows: 

 
The Drawing Scale and Annotation Scale Lock 

As shown, this tool controls the scaling of all Annotation enabled elements including linestyles, text, 
dimensions, and cells.  This tool should be used to control the scaling of any OpenRoads data.  Care 
should be given to using this in addition to other manual scaling factors as the results could be incorrect. 
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With the Annotation Scale Lock enabled (highlighted in light blue as shown above), changing the scaling 
value above it will dynamically rescale all elements by the defined value. 

With the frequency that these controls in particular will be used, it’s advised that this particular set of 
tools be pinned to all workflows using the process discussed in the INDOTWise 5.1 MicroStation 
Platform document. 

Note: Initially all items should be drawn up at a Full Scale 1:1 setting.  Drawing items up at higher scales 
may cause them to improperly display in your drawing.  This can be resolved by setting the scale back to 
Full Scale 1:1 and then selecting the desired scale from the listing. 

The following table shows the various drawing scales configured in our workspace, along with their 
equivalent direct scale factors. 

Scale Name  Scale Factor 
Full Size 1=1 1:1 
6"=1'-0" 2:1 
3"=1'-0" 4:1 
1 1/2"=1'-0" 8:1 
1"=1'-0" 12:1 
3/4"=1'-0" 16:1 
1/2"=1'-0" 21:1 
3/8"=1'-0" 32:1 
1/4"=1'-0" 48:1 
3/16"=1'-0" 64:1 
1/8"=1'-0" 96:1 
1/16"=1'-0" 192:1 
1/32"=1'-0" 384:1 
1"=10' 120:1 
1"=20' 240:1 
1"=30' 360:1 
1"=40' 480:1 
1"=50' 600:1 
1"=60' 720:1 
1"=100' 1200:1 
1"=200' 2400:1 
1"=300' 3600:1 
1"=400' 4800:1 
1"=500' 6000:1 
1"=600' 7200:1 
1"=1000' 12000:1 
1”=2000’ 24000:1 
1”=3000’ 36000:1 

Drawing Scale Chart 
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1.5-6  File Referencing 
As discussed previously, OpenRoads data is now all stored directly in DGN files.  One major advantage of 
this functionality is that standard MicroStation referencing allows for OpenRoads data to be visible 
through the reference documents.  Examples of this functionality will be discussed further in the coming 
chapters, particularly in areas such as the creation of a terrain model from a referenced survey field 
book, and in the modeling of a corridor from referenced terrain and geometry files. 

1.5-7  ORD Heads-Up Display (HUD) 
New to OpenRoads Designer is the heads-up display (HUD).  The HUD provides a menu of options for 
various elements when they are selected.  To activate the HUD for a particular element, left click on it 
and then hover the mouse pointer over it.  In the below example, the boundary of a terrain is selected—
which activates the HUD where you can activate the terrain in the model. 

 

Using the HUD to Activate Terrain 

1.6 Built-in Imagery in OpenRoads Designer 

As of the release of OpenRoads Designer, Bentley has provided functionality to allow a user to apply 
background map imagery to a geocoordinated design file via Bing Maps.  This section will outline the 
process to apply this imagery: 
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1. With a geocoordinated design file open, click on the View Attributes button in the top left 
corner of the view window. 

 
View Attributes Button 

2. On the View Attributes window that appears, locate the Background Map dropdown menu at 
the bottom of the window. 

 
Background Map 

3. Click on the menu, which will open to show two settings: Background Map Type, and 
Transparency. 

 
Background Map Settings 
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4. The Background Map Type setting provides four options, which are explained below.  Select 
from one of the options as needed: 

• None: No background map imagery is displayed. 
• Street Map: Displays a street map in the background. 

 
Street Map Background 

• Aerial:  Displays aerial imagery in the background. 

 
Aerial Background 

• Hybrid: Displays a combination of aerial and map imagery in the background. 

 
Hybrid Background 
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5. With the desired background map type selected, the transparency of the imagery can be 
adjusted via the Transparency setting: 

 
Aerial Background with 50% Transparency 

Note: The provided Bing maps imagery should only be used as a reference guide.  The imagery is not 
survey grade and you may notice inconsistency and inaccuracy when comparing to the Best Available 
WMS imagery, or when looking at survey provided data. 

1.7 Export to SHP File 

Starting with OpenRoads Designer 2023, Bentley has re-incorporated a rudimentary GIS Shapefile export 
tool.  This new tool can be found on the OpenRoads Modeling workflow on the Home ribbon in the 
Model Import/Export section. 

  
Export to SHP 

Note: When exporting data through the Export to SHP tool, the following should be considered: 

1. This tool is currently implemented only in a Technical Preview mode; expect further changes to 
its functionality in newer iterations of the software. 

2. Currently, exports should not be sent directly to ProjectWise.  The tool does not accommodate 
the SHP file and its associated content as currently developed.  A support case has been 
submitted to Bentley regarding this functionality.  The process as defined will be to export the 
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content to a local drive (i.e. C:\temp\GIS Export or similar) and then drag/drop into ProjectWise 
to share with other users. 

3. The active selection set will be used to export.  This can be a combination of content and element 
types, but it’s strongly advised that a single feature type be exported to a shapefile to aid in 
identification and resymbolization adjustments in ESRI. 

4. When exported, the shapefile and associated files will default to the name of the active file.  
Easily identifiable naming should be used at the time of Export to simplify content identification. 

5. On the ESRI side, the shape file content will not by default be visible.  ArcGIS Pro users will need 
to toggle on the Enable symbol layer drawing toggle in their Symbology settings for the exported 
content to be visible. 

6. Again, in ArcGIS Pro, exported content will be assigned a default symbology.  The export from 
OpenRoads Designer does not send across its symbology definition.  The ArcGIS Pro user will 
need to adjust the symbology once added and displayed in their ArcGIS Pro project. 

To use the Export to SHP tool: 

1. Select content in the file that should be sent to GIS.  The below illustration shows the selection 
of the surveyed overhead utility line. 

 
Element Selection 

2. With the appropriate elements selected, select the Export to SHP command on the OpenRoads 
Modeling workflow, Home ribbon. 

 
Export to SHP 
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3. When presented the Export to SHP dialog, unless needed, the Export Shapes in 3D can stay 
disabled.  Select a datapoint in the display to confirm the export. 

 
Export to SHP 

4. The export process will then prompt to set a location and filename for the shapefile.  As 
mentioned in the notes, do not perform this export directly to ProjectWise, select a location on 
the local drive.  To bypass the ProjectWise creation, select Cancel when prompted to use the 
standard Windows browser.  This example will use C:\temp\GIS Export; and for the filename, 
will use Overhead Utility.shp.  Select Save to complete the export. 

 
Export to SHP – Local Drive 
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5. Review the exported content at the path previous specified.  In this location, one should see a 
number of files named consistently with that set in the previous step.  All of these files are 
necessary for inclusion in a GIS project and should be provided together to the next user. 

To illustrate what might be seen in ArcGIS Pro, the shapefile can be attached to a project and 
resymbolized to differentiate it from other date.  It should be noted that this tool will export generic 
element data and not include any level or symbology information.  If the elements have any item type 
information however, this will be processed and sent over for further investigation.  Below is an example 
of what this data could be illustrated as: 

 
Exported Shapefile in ArcGIS Pro 
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1.8 Importing ESRI Terrain into ORD 

OpenRoads Designer allows users to import terrain directly from ESRI.  The Topo Import tool—found on 
the Terrain tab of the OpenRoads Modeling and Survey workflows—can accomplish this task. 

 

Topo Import Tool in OpenRoads Modeling Workflow 

Before discussing the use of the tool itself, there are a few things to know before using it.   

• You MUST be in a 3D model for it to work. 
• The bounding element you create to bring in the terrain must be an actual element—it 

CANNOT be a fence. 
• Be very careful in how dense you make the terrain that you import.  Making a terrain 

that is too dense can severely affect the processing speed of the Topo Import tool and 
adversely affect the overall performance of your file. 

• Keep in mind that this functionality is in a Technology Preview phase at this time—so 
the functionality is not set in stone, and can thus be modified by Bentley at any time. 

The process to use the tool is as follows: 

1. The first step is to create the bounding element that you will use to bring in the terrain.  In this 
example, a simple block will be used. 

 

Bounding Element for Imported ESRI Terrain 
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2. Next, click on the Topo Import tool to activate it.  You will then be provided with an ArcGIS login 
window. 

 

ArcGIS Login Window 

3. On the ArcGIS login window, select the dropdown for Your ArcGIS organization’s URL, and enter 
“indot” in the provided field.  Then click Continue to proceed. 

 

Entering “indot” for Your ArcGIS organization’s URL Field 
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4. On the next screen that appears, click on the ArcGIS login dropdown.  Proceed to enter the 
following credentials and sign in: 

• Username: CADsupportGIS 
• Password: MIS28!cad 

 

Login Credentials for ArcGIS Login 

5. Once you’ve signed in, you’ll be prompted for your area of interest.  Before you select your 
bounding element, take note of the settings in the Topo Import dialog box. 

 

Topo Import Dialog Box 

• Offset: Allows you to import terrain outside of your bounding element.  You can specify a 
distance to offset if you wish to do so.  Otherwise, specifying a value of 0 will only import 
the terrain within the bounding element.  Be sure to enable the setting via the checkbox to 
lock it in place when you select your bounding element. 

• Clip: The intent of this setting is to remove unnecessary points from the imported terrain.    
The underlying calculations/analysis being performed are unknown at this time. What we 
have observed is that enabling this setting cuts down the estimated point count for the 
specified resolution value by an approximate factor of 10.  We will provide more 
information on this setting once it is officially implemented in a future release. 
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• Resolution: Defines the density of the terrain what will be imported into your file.  
Specifically, it defines the approximate width of one square within the bounding element 
that will be split into two triangles to form the terrain.  Note: There is currently a defect 
with this setting, where the value you provide is converted to metric, and the resulting 
square width uses that converted value, but in feet.  To avoid this issue, you will need to 
utilize a conversion factor of 3.28 to get the square width that you actually want.  For 
example, if you would want a square width of approximately 100 ft to establish your 
terrain, you would specify a value of 100 x 3.28 = 328 for this setting.  See illustration of 
this example below: 

  

Resolution Setting to Obtain an Approximate Square Width of 100 ft 

 

Measured Distance of Square Width 

• Feature Definition: Specifies the feature definition that will be applied to the imported 
terrain.  In this example, we are specifying the Existing_Contours_5 : 1.0 feature definition. 

• Name: Specifies the name you want to give the imported terrain. 
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6. Once you have your desired settings specified in the Topo Import dialog box, select the 
bounding element.  You can take note of the estimated point count that is then shown in the 
heads-up display (HUD). 

 

Estimated Point Count in Heads-Up Display 

7. Left-click twice more to accept the import operation, and the ESRI terrain will then be imported 
into your file. 

 

Imported ESRI Terrain 

8. As a final step, you can apply an annotation scale to your 3D model such that you can view the 
contour label annotation. 
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Annotation Scale Applied to Imported Terrain 
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2. Using OpenRoads Designer for Survey/Routeplat Production 
The following sections discuss the usage of OpenRoads Designer for Routeplat development.  These 
procedures should be used for the development of survey deliverables as noted in Chapter 106 
(formerly chapter 26) of the INDOT Design Manual.  More in-depth discussion of these procedures can 
be found in the 2020 - INDOT ORD for Survey learning path published on the Bentley Learning Network. 

In addition to the OpenRoads Designer-specific tools noted throughout this section, also keep in mind 
the Survey tools provided in the Survey tab of the INDOT Tools workflow. 

 
Survey Tools in INDOT Tools Workflow 

2.1 What’s Changed with Survey in OpenRoads 

With the release of OpenRoads Survey, the following coding changes have been necessitated: 

New Control Codes have been incorporated to replace the +O, +D, +H InRoads offset note commands.  
Note that the (-) indicates which direction would be a negative value: 

• AD* is for vertical offsets, Up/Down(-)   
o Example: AD*-2 UE02 B would result in UE02 2 feet below the observation at the start 

of the string. 
• NF* is for distance offset, Front(-)/Back   

o Example: NF*4.5 PTCS would result in PTCS 4.5 feet back from the observation. 
• LR* are for left/right offsets, Up/Down(-)   

o Example: LR*-7 TB04 would result in TB04 7 feet to the left of the observation. 

The EXTARC code can no longer be used to create a closed 3 point circle.  Advisement from Bentley is 
that circles should have 4 shots, with the fourth shot being near the first shot so only a small linear 
element closes out the circle. 

OpenRoads will automatically draw up and place text consistent with the old planimetric graphics.  
However, these do not dynamically scale and now rely on MicroStation Drawing Scale tools.   

NOTE: There is a known defect with ORD where survey graphics sometimes do no respond to changes in 
annotation scale.  Bentley and CAD Support are aware of this.  If this issue occurs, instead of being able 
to create the survey fieldbook first and then adjust the annotation scale on the fly as needed, you will 
need to set the annotation scale first and then redraw the survey data. 

https://www.in.gov/indot/design_manual/
https://learn.bentley.com/app/Public/ViewLearningPathDetails?lpId=114008&callFrom=MyLp&aftkn=2bc7180b-0e8d-4133-9c27-fb11ce9c8bb8
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2.2 Creating OpenRoads Survey Deliverable Files 

With the move to OpenRoads technology for Survey, there are some slight changes to the project 
deliverables when compared to SS4 and SS10.  The following workflow will step through the process of 
creating each file for a survey project.  It is assumed that the user will be working from the Survey 
workflow in OpenRoads Designer. 

As the intent is that every project should now be geocoordinated, the first document in the workflow 
will be the geocoordinated seed files.  These will allow for all project files to be created and based off 
the same coordinate system, allowing the file content to be shown spatially without the need to 
configure each individual file. 

2.2-1  Creating the Geocoordinated Seed Files (2D and 3D) 
The following procedure steps through the process for creating the geocoordinated seed file for use 
through the project lifecycle.  The creation of these files allows for any CAD files based on the created 
seed file to be instantly consumed by the ESRI ArcGIS Products and made available for a variety of other 
uses.  With OpenRoads changes to document handling and civil information, these steps should be 
performed for both a 2D and 3D file (shown).   

1. After creating your Survey Work Area in your Des No. specific project via the DOTWise project 
creator, navigate to the Project Files folder: 

 
Survey Project Files Location 
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2. With the Project Files folder selected and its contents displayed in the Document pane, right 
click in the document pane and select New -> Document. 

 
Starting the New Document Wizard 

3. You will then be presented with a series of options; select the Advanced Wizard option. 

 
Using OpenRoads Designer for Design/Plans Production 

4. This will start the Advanced Documentation Creation Wizard.  The first panel is informational 
and can be bypassed.  The second panel confirms your location.  If for some reason you did not 
have the correct folder active in your document panel, you can select it now or confirm the path 
shown. 

5. The next panel allows selection of the template document.  On the first line “Use a ProjectWise 
document as a template” option and then press the select button. 

 
Select a Template dialog 
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6. In the “Select Template Document” panel, navigate to the ORD-Connect Seed files in the 
ProjectWise System and select the appropriate unit files for your project and that the file you 
select is the 3D version: 
pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template Documents\ORD-Connect Seed\ 

 
Selecting a US Survey Foot OpenRoads Designer Seed File 

7. With your file selected, you can then proceed to the next screen.  If you are prompted for 
Document Attributes, you may proceed beyond this screen as well. 

  

pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5C
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8. The final step in creating the document is to provide a name.  Seed drawings should be titled 
with the following format: Des #_SRxx Seed 3D.dgn.  To ease document searches and for 
consistency purposes, all three names should be the same as shown.  Also worth noting is the 
Application dropdown, as it illustrates the OpenRoads Designer association as shown in the 
following screen capture. 

  
Document Properties and Naming 

9. Select Next to complete the document naming process.  On the final two pages of the wizard, 
confirm the document properties and create the document.  Proceed through these and then 
continue in the same Project Files folder. 

10. Navigate to your newly created seed file in the Survey\Project Files folder & double click on the 
file to open it in OpenRoads Designer. (Allow for Managed Workspace to download).   

 
Created Seed File 
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11. Open the Geographic Coordinate System dialog by clicking on the Coordinate System tool on the 
Geographic tab (assumed the user is in the Survey workflow). 

 
Coordinate System Tool 

12. In the Geographic Coordinate System dialog, click on the From Library button.  

 
From Library Button in Geographic Coordinate System Dialog 

At this point, the Select Geographic Coordinate System dialog is displayed.  The Library tab in this dialog 
contains folders with all the available coordinate systems.  The Favorites, ProjectGCS, AgencyGCS, and 
Library are the folders you will see.  In the ProjectGCS as well as the AgencyGCS folders, there will be a 
list of coordinate Systems for Indiana State Plane East and West and the Local Ground Coordinate 
System (LGCS) templates.. 
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13. At this point in the process, you may have data that can use one of the county coordinate 
systems located under one of the district folders under Favorites—which contains the 
coordinate systems for all of the counties that reside in their respective district.  Alternatively, 
you can select the county coordinate system under the AgencyGCS folder.  If your data conforms 
to this configuration, please select and apply the correct coordinate system at this time. 

 
Select Geographic Coordinate System Dialog 

Note: Moving into OpenRoads Designer 2023, Survey Foot based Geographic Coordinate Systems have 
been incorporated into the platform and will be available with newly created data.  The following dialog 
shown on the next page will only be visible if the ProjectGCS from a legacy project is being used or the 
coordinate system is imported from a file created from the legacy Metric coordinate systems.  These 
systems are compatible, and project data can be a mix of the Survey Foot and legacy Metric systems with 
no impact to geospatial relationships between CAD files.  All other spatial data such as imagery or 
imported GIS data will reproject as necessary between the coordinate systems without issue as well. 
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14. A pop-up dialog may appear asking you to choose whether you want to reproject the data based 
on this newly applied coordinate system.  Be sure to select the option to keep the storage units 
as they are (should not be changed) as shown below. 

 
Keeping Storage Units 

15. The newly selected Coordinate System will now appear in the Geographic Coordinate System 
dialog window as shown: 

 
Applied Coordinate System 

16. Upon completion of these steps, you will need to exit OpenRoads Designer and check in your 
CAD file.  Please add comments upon check-in. 

 
Checking In CAD File 
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With the LGCS defined within the dgn file the survey can be processed through InRoads in the typical 
manner.  The only difference is that MicroStation knows the parameters to convert data in any other 
standard coordinate system to the LGCS.  This means that ortho-imagery, GIS files, etc. can be 
referenced to the dgn file and MicroStation will re-project them to the LGCS on-the-fly so that the data 
is all spatially referenced.  

2.2-2  Creating the Survey Fieldbook DGN file 
Creating the fieldbook DGN file is the first instance where you will find the need to choose a particular 
seed file.  In this instance, you will need to start with the 3D geocoordinated seed file you created in the 
previous section.   

Note:  Provided the supplied data correctly adheres to the county coordinate systems that are provided 
in the geocoordination library, you may also apply the appropriate GCS to the file directly as shown in the 
previous section. 

1. Using the Des #_SRxx Seed 3D.dgn you created in the previous section, create a new document 
under your Survey\Project Files folder.  Use the Advanced Document Wizard and instead of 
pointing to a pre-existing seed file, point back to the Des #_SRxx Seed 3D.dgn.  Name this file 
Des #_SRxx Survey Fieldbook.dgn. 
 
Note: By using the seed file created in the previous steps you will ensure starting off with a 
correctly geocoordinated file.  All subsequent DGNs should be created using this seed as your 
starting file. 

 
Creating the Survey Fieldbook DGN 

2. Launch the DGN file from the ProjectWise Explorer by double clicking on it. 
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3. With OpenRoads Designer loaded, locate the Project Explorer and navigate to the Survey 
section.  Expand the Default tab so that Field Books are visible. 

 
Survey Project Explorer 

4. With the Field Books shown, right click on their entry.  Select New... 

 
Creating a New Field Book 
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5. A field book will then be created.  Note that you are not initially given the option to give it a 
name, as it will be automatically created as Field Book 1.  To change this, right click on the field 
book and select Properties.  The field book information will then show up in the OpenRoads 
Designer Element Information panel, like any other OpenRoads element.  You can rename it in 
the Name field—and it is recommended to maintain the Des #_SRxx convention. 

 
Renaming a Field Book 

6. With the field book renamed, you can now import your data.  Right click on the field book and 
select Import > File…  OpenRoads field books allow for the import of a wide variety of data types 
and formats.  Additionally, existing FWD surveys from SS2 can be directly imported into the 
OpenRoads environment using this tool. 

 
Importing Survey Data 
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7. On the presented ProjectWise Open dialog, navigate to your Survey\_Raw Data folder and 
locate your data collector file(s) to attach them. 

8. With your data files attached, you will see output similar to the following. 

 
Raw Survey Data in OpenRoads Designer 

9. As you can see, there appear to be numerous issues with the TOPO display. 
a. First are the points denoted with the exclamation point (!) icon.  These are points that 

the OpenRoads environment does not have codes for.  These should be adjusted to 
known codes within the environment. 

b. Point symbols and linestyles are not displaying properly.  Using the Drawing Scale tools 
mentioned in section 1.5-5 of this document, first enable Annotation Scale Lock, and 
then pick your required scale.  This example will proceed with using 1” = 50’.  To 
reiterate the note from the beginning of the chapter, as of this writing, in the current 
ORD version (ORD 2021 R2) your survey data may not respond to changing the 
annotation scale.  If this happens, you will need to set the annotation scale FIRST, and 
then redraw the survey data. 

c. Linework denoting both the observations themselves, along with the instrument setups 
will be displayed.  In the Survey section of Project Explorer, disable these two options 
prior to handing your data to design. 

 
Disabling Setups and Observations 
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d. Finally, survey notation information will appear around each point, like the old 
planimetric graphics in SS2.  To disable these, open the Level Display and disable the 
levels shown.  Alternatively, you can right click on the ALL Point Features in the Survey 
Fieldbook and select Annotations -> Turn Off All Annotations.  You can also turn them 
off from the Decorations section of the Analyze tab in the ribbon. 

 
Disable Survey Notation Graphics 

 
Turn Off All Annotations 

 
Decorations Section of Analyze Tab 
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10. With these previous items resolved, your TOPO display will now look like the following and in 
line with expectations. 

 
Cleaned up TOPO Display 

NOTE: From time to time, the line styles that contain embedded text may not appear correctly, with the 
text symbol being disproportionately large.  If this happens, please refer to the INDOTWise 5.1 
Technotes document, in the CAD Workspace/MicroStation Platform section. 

11. With the fieldbook now created, you can proceed to saving your file back to ProjectWise.  
Before closing the document, first save the settings.  This can be done by clicking on the Save 
Settings button on the Quick Access toolbar, or via selecting Save Settings from the File 
menu/Backstage View.  Then close the application and check in your file. 

 

2.2-2a Editing Fieldbook Features 
Unlike the previous version where all features were edited in the fieldbook in line with how they were 
shot, OpenRoads Survey prioritizes the individual features from an editing standpoint.  To interrogate 
individual features, you have multiple options on how to interact with them.  This section will take a 
brief look at two of the more immediate methods. 

First up is the table-based editor.  With your fieldbook open and selected, drill down to either the ALL 
Point or ALL Linear Features and select one of the codes.  Keep in mind that all breaklines will also have 
point definitions as that’s how OpenRoads defines them.  With a point or linear feature selected, go to 
the Details tool in the Primary Group of the Field Book tab. 
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Survey Details Tool 

This will open a tabular view of the selected feature.  Depending on the feature selected, you can 
change the name of the feature or shot, if it is included in the triangulation, or 
northing/easting/elevations, and other items.  To modify any field, place your cursor within it.  If it is a 
dropdown, you will be presented with the applicable options.  If it is a text entry field, enter the 
appropriate information.  In both instances, once complete, hit the Tab key to confirm the change. 

 
Survey Details 
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The other method of editing surveyed features is graphically.  In the main display that shows your TOPO 
elements, you can select on any feature and review its properties in the Element Information panel.  In 
this view you can edit the same data as you can in the details.  Additionally, in the graphical side, all 
elements will be given heads up element handles that you can grab and manipulate. 

 
Graphically Editing Survey Data 

 

Heads-Up Display on Deciduous Tree Survey Feature 
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2.2-3  Creating the Terrain Model 
With the Survey Fieldbook now created, you will need to create the OpenRoads Terrain model.  Note 
that it is no longer necessary to create a boundary surface as it is automatically created when the terrain 
model is generated.  This boundary is automatically defined by the extents of the triangulation and will 
automatically update as you are editing features or the triangulation itself. 

1. To proceed with terrain generation, re-open your survey field book DGN from the previous 
steps. 

2. Navigate to the Survey section on the Project Explorer.  Right click on your Des #_SRxx field book 
and select the Create Terrain Model… option. 

 
Create Terrain Model 
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3. When processing is completed, the terrain model will be created and displayed.  The default 
display style is to show Existing Contours at a 5:1 scale.  The display will look like the following. 

 
Survey with Created Terrain Model 

4. At this time, you can investigate the terrain model.  To select it, go to the OpenRoads Model 
section on the Project Explorer.  Expand out the Terrain Models listing on the tree and select 
Des #_SRxx Survey Fieldbook. 

 
The Terrain Model 
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5. By selecting the Terrain Model, you can then interrogate its properties in the Properties panel.  
Reviewing the terrain in the panel allows you to control display items such as the maximum 
length of triangles, whether contours should be displayed, displaying the triangulation, etc.  The 
following shows all the relevant settings for controlling the terrain display. 

 
Terrain Model Element Information 
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6. With the terrain model now having display settings for items such as the perimeter, contours 
and triangulation, it is no longer necessary to use the Level Display to disable these items.  
Simply use the Element information panel to shut these items off in preparation for the final 
deliverables. 

 
TOPO Display with Terrain Display Off 

7. At any time, these features can be redisplayed simply by toggling the relevant feature on. 
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8. For the terrain to correctly display in referenced documents, make sure it has been activated.  
Again, on the OpenRoads Model section in Project Explorer, right click on your terrain and select 
the Set As Active Terrain Model option.  Alternatively, you can activate it via the heads-up 
display (HUD). 

 
Set Active Terrain Model in ProjectWise Explorer 

 
Set Active Terrain in Heads-Up Display 

Note: This workflow no longer allows for the editing of features once they have been sent to the terrain 
model as it becomes a “ruled” feature.  If any changes are needed to surveyed features, the terrain 
should be deleted and recreated from the field book once the changes have been made. 
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2.2-3a Triangulation Clean Up and Terrain Editing 
OpenRoads terrains have similar commands to the previous version of InRoads allowing for the 
modification of a triangulated terrain.  The first option to clean up the triangulation extents is to adjust 
the max length of the triangles it creates. 

In the software, select your terrain either from the Project Explorer, or graphically select the terrain 
perimeter on the screen.  In either instance, select the Properties button. 
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On the Properties panel for your terrain, locate the Edge Method heading and from there you can adjust 
the max length as you did when triangulating a DTM in the old version.  From here, you can tighten up 
the triangle lengths to get a more defined perimeter for your project without editing the terrain content. 

 
Max Edge Length Setting 

Note: Changing the triangles max length will force the full triangulation to re-process.  Please make sure 
to have this value finalized prior to performing any further terrain edits. 

Additionally, you can directly edit the terrain by disconnecting the survey processing rules to allow for 
such functions as cleaning up any unnecessary triangles.  These steps will look at how to disconnect the 
terrain from the survey for editing. 

1. Locate the Survey section on the Project Explorer.  Right click on the model name (in this 
example, Default) 

2. Select the Deactivate Survey Processing Rules option. 

 
Deactivate Survey Processing Rules 
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This process disconnects your field book and terrain completely.  Changes made to the field book will no 
longer automatically be reflected to the terrain.  This is like how the DTM and FWD were disconnected 
outside the Survey Data to Surface process.  Although they are in the same file, they co-exist as two 
separate entities. 

With this disconnection completed, you can then use the terrain editing tools to interact with the terrain 
for functions such as cleaning up triangles.  Please keep in mind that all terrain edits must occur in a 3D 
model.  For instance, to delete triangles: 

1. Continuing from the previous steps where the survey and terrain model were disconnected, 
click on the Edit Model tool from the Edit Group in the Terrain tab. 

 
Edit Model Tool 

2. At this point you can modify the triangulation in a number of ways.  One of the most useful is 
the ability to remove triangles with a crossing line.  The 6th tool on this panel (highlighted) is the 
Delete Triangle by Line command.  Select it and then click on your terrain model. 

 
Delete Triangle by Line 
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3. With the terrain selected, draw a line as prompted across all the triangles that you wish to 
remove.  The bold lines indicate the crossing line as well as the outline of the triangles to be 
removed.  Confirm what’s to be cut with a single data point click. 

 
Before Trimming  Trimmed Result 

This same methodology can be applied to most of the terrain editing tools.  It is imperative however, 
that as we did earlier in this chapter that the survey and terrain be disconnected through the survey rule 
deactivation. 

Throughout this section you have looked at how terrain editing works with the survey disconnected.  As 
an extension of this, one may ask what happens if you turn the survey rules back on.  To do so, reverse 
the process in the first part of this section and you will receive the following prompt: 

 
Reactivation of Survey Rules 

Selecting Yes will cause the terrain and survey to relink.  It will also re-establish the terrain back to how it 
was created from the survey, removing any changes or cleanup performed. 
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2.2-4  Verifying Topo using 3D Rotation and Shading the Triangulation 
The View toolbar (located in the upper left of the view window) gives access to rotate 3D drawings to 
any one of 9 predefined Views.  Isometric View and Right Isometric View are the most useful to rotate 
quickly to a 3D orientation.  Option number 1 – Rotate View allows dynamic view rotation. 

 

Results will be similar to below. 
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Note:  Alternate access to 3D rotation can be obtained from mouse functions.  This involves the Alt-
Middle dynamic rotation.  This is also the same as Option 1 Rotate View - dynamically 

Alt & Middle click 

 

The Drawing View will have a crosshair placed in the drawing.  This is automatically placed at the center 
of the graphical elements in the drawings. 
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Any subsequent rotation will be about this point unless you dictate otherwise.  (This is rarely the desired 
location.) 

The rotation origin can be modified by tentatively snapping to the desired location (left right chord) or 
by graphically dragging the cursor to a new location.  When the cursor is moved over the crosshairs they 
become highlighted as shown. 

 

Press and hold the left mouse to graphically drag to a new rotation origin.  AccuSnap is particularly 
useful in this operation.  When the left button is released, so is the cursor at the new location.   

Subsequent left mouse dragging will dynamically rotate the drawing.  (Make sure you are no longer over 
the origin.) 

 
Results of left drag with triangulation displayed as reference:
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Note: Subsequent panning and additional Dynamic rotation will change the perspective, allowing you 
to see any portion of the project from any angle 

Returning to Plan View 

In CAD, the normal Plan View is referred to as Top View. 

Simply select the icon to the right of Fit view. 

 

Resulting view: 
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You also may wish to verify the triangulation by applying shading to see if any holes exist.  With your 
triangulation displayed, click on the View Attributes button on the upper left hand corner of your active 
MicroStation view.  The very top option for presentation will be listed as wireframe by default.  Change 
this setting to smooth as shown, and your triangulation will look as shown. 

 
Smooth Shading on View Attributes 

 
Topo with Smooth Shading 

You can switch back to the wireframe display by performing the same steps, changing from Smooth and 
back to Wireframe.  Note that there are additional display styles available that can also be used. 
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2.2-5  Creating the Survey Alignment File 
To create a survey alignment file, the first step is to create a new 2D geocoordinated seed file per the 
instructions in section 2.2-1.  Then proceed with the following instructions: 

7. Using the Des #_SRxx Seed 2D.dgn that you should have already created, create a new 
document under your Survey\Project Files folder.  Use the Advanced Document Wizard and 
instead of pointing to a pre-existing seed file, point back to the Des #_SRxx Seed 2D.dgn.  Name 
this file Des #_SRxx Survey Alignment.dgn. 

 
Creating Survey Alignment File 

8. Launch this newly created file from ProjectWise Explorer. 
9. Once in the survey alignment file, proceed to attach the survey fieldbook file to access the 

terrain model and topo features.  In the Primary tool group on the Home tab, click on the Attach 
Tools button and proceed to attach the survey fieldbook file. 

 
Attach Tools Button 
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Survey Fieldbook Attachment Settings 

10. As shown above, the Detail Scale and Global LineStyle Scale settings are specifically called out.  
These two settings should always be set as shown for Drawing Scale to scale them correctly.  
Proceed to attach the survey fieldbook with these settings.  Then, set the Annotation Scale in 
the alignment file to be consistent with the fieldbook (1” = 50’) in this case. 
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11. With the fieldbook attached, activate the terrain associated with it.  This will create and 
reference attach an additional model with a -3D added to its name. 

 
Activating the Attached Terrain from Fieldbook 

6. With the fieldbook attached and terrain activated, you will now see the terrain model on the 
OpenRoads Model tab in Project Explorer under Referenced Models. 

 
Activated Terrain Model in Project Explorer 
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7. At this point, you can start creating your survey alignment.  The first step in the process is to set 
the appropriate element template for the alignment.    To do this, navigate to the Home tab, and 
in the Attributes tool group select the Element Template dropdown.  Then on the Element 
Template dropdown, navigate to Survey > Geometry > S_ALG_Alignment.   This will 
automatically set the correct properties (level, color, line style, etc.) for the alignment you will 
be creating. 

 
Setting Element Template for Survey Alignment 

8. After setting the element template, you can navigate to the Geometry tab and use the 
Horizontal Geometry tools to create your alignment. 

 
Horizontal Geometry Tools 
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9. Upon the completion of creating the alignment, you will need to create a complex element out 
of it.  In this example, the Complex By Element tool will be used.  Ensure the S_ALG_Alignment 
feature definition is selected.  If it is not, click on the Feature Definition dropdown and navigate 
to Alignment > S_ALG_Alignment to select it.  Then enter the name of your alignment.  Line A is 
used in this example.  Once the name is entered, proceed to select the individual elements of 
your alignment to create the single complex element. 

 
Create Complex Element with Alignment Name 

2.2-6  Updating Older Survey Data to OpenRoads Designer 
Importing a field book from older survey data can be a very straightforward process.  This section will 
cover two methods to accomplish this.  The first method to be discussed is to import an FWD file 
directly.  The second method is to take an existing survey in SS10, convert its data to LandXML and then 
import it into ORD.  

2.2-6a Importing Survey Data from FWD Files 
This section will cover how to import survey data into ORD directly from FWD files.  Please keep in mind 
that while reviewing these instructions, the extent of additional cleanup that will need to occur will 
depend heavily on if 3-point circles were created using the EXTARC command or if offsets were coded as 
part of the notes (+O, +D, +H).  The following steps will cover how to import FWD files, and in the case of 
the offsets, how to find and modify the shot so the output is correct. 

1. To import an FWD field book file, navigate to the Survey section on the Project Explorer. 
2. On the Field Books heading, right click and create your Field Book.  Please use the standard Des 

#_SRXX naming conventions. 

 
New Field Book 
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3. Right click on the newly created field book entry and select the Import -> File… option.  Navigate 
to your FWD file and open it. 

 
Import Field Book from File 

4. OpenRoads Survey will now import this data and create the field book and graphics. 
5. If your survey did not use any offsets in the Note field (Descriptions in OpenRoads), you can 

proceed to work with the survey using the OpenRoads tools as you have throughout this 
chapter. 

6. If your survey contains offset notes, at this time these will need cleaned up so your data is 
consistent across versions.  Continue for how to resolve these changes. 
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7. Select the All Point Features from the field book on the Project Explorer. 

 
ALL Point Features Selected 

8. On the Field Book tab in the Ribbon, select the Details tool from the Primary Group.  This will 
open the table view with all your points. 

 
Details Tool on Field Book Tab 
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9. On the table view, right click on the Description field and use one of the sorting methods.  Be 
advised that this is just a single method, and you can also use the find commands, or even drill 
down to specific features and perform similar steps.  For this example, you will be using the Sort 
Ascending command. 

 
Sorting Point Features 

10. With the list sorted, all common offset notes in the Description field will be grouped together.  
You may either scroll down to where these are or use the Find… command to quickly jump to 
these in the list. 

  

 
Sorted by Description 
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11. Click on the Control Codes field for one of the entries.  Unfortunately, this tool does not support 
bulk edits.  In the case of the following example, you have a left offset of 1 foot, so the Control 
Code will be set to LeftRight and a value of -1 entered.  Please keep in mind that you must use 
the Tab Key in the Value field for the record to be confirmed.  Repeat this step for any point 
necessary. 

 
Modifying/Adding a Control Code for Left/Right Offsets 

12. Locating your point in the display, it will appear that it has not moved to the offset entered.  
Much like InRoads before, the display will need redrawn.  To do so, go to the Analyze Tab, and in 
the View Group, select the Redraw tool.  Your observation will then be reflected in the TOPO. 

 
Redraw the Survey 

At this point you will have the survey migrated over to OpenRoads Designer.  Note that there will still be 
clean up needed, such as resolving any 3-point circles or other coding issues that the above did not fix.  
In many instances, bringing the survey forward should be a quick and painless process. 
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2.2-6b Importing Survey Data in LandXML Format 
This section will cover how to take an existing survey in SS10 and convert it to LandXML format to 
import into ORD. 

Note: When exporting survey data from SS10, make sure to disable the Setups and Observations entries 
under the fieldbook.  A defect has been found and logged, and having these enabled will prevent survey 
notes (descriptions) from properly coming across. 

1. With your survey fieldbook file open in InRoads SS10, navigate to the Survey tab in Project 
Explorer and expand the Field Books folder to show the created fieldbook. 

 
Survey Field Book 

2. Right-click on the field book listing and select Export To > LandXML Format. 

 
Export to LandXML Format 
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3. You will then be prompted to provide a name for the exported file and its saved location in 
either ProjectWise or locally on your computer.  Specify these settings as desired. 

4. In a brand-new survey fieldbook file in ORD, create a new field book as specified is section 2.2-2. 
5. Right-click on the new fieldbook listing in Project Explorer and select Import > File from the 

menu. 

 
Importing LandXML File 

6. Select the LandXML file you exported out from SS10 and proceed with the import.  The survey 
data will now be imported into the file.  

 
Imported Survey in LandXML Format 
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2.3 Routeplat, Reference Box and Section Corner Card Creation 

The following sections will walk through the process to create a complete route plat sheet.  This will 
include creating the file in ProjectWise, examining its contents, and working with/referencing section 
corners. 

2.3-1  Creating the Route Plat .dgn File 
Prior to placing any content into the route plat, you need to create a drawing to work in.  This process 
will be same to the steps performed in section 2.2-2. 

Using these steps, you will need to make two adjustments. 

1. When selecting your seed file, select the appropriate unit file from:   
pw:\\indot-pw.bentley.com:indot-pw-01\Documents\Template Documents\ORD-Connect 
Seed\Survey Seed Files\ 

 
Selecting a Route Plat Seed 

  

pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSurvey%20Seed%20Files%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CSurvey%20Seed%20Files%5C
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2. Your document name, description and file name should all be set in the Des #_SRxx LCRS 
Plat.dgn format. 

 
Route Plat Naming 

2.3-2  Contents of the Route Plat Template Files 
Each of the route plat templates contains five models.  These can be accessed by going to the Models 
icon in the OpenRoads Designer Ribbon: 

 
Accessing the Models Dialog 

By selecting this icon, you will be presented with the following window and list of available models: 
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Available Models in the Template 

The five models available are: 

1. Coordinate Table – This is the template Reference Point Coordinate Table. 
2. Default – This is the default MicroStation model and is available in all .dgn files. 
3. Plat – This is the template route plat sheet model. 
4. Point Number – This is the template reference box model. 
5. SV_Section Corner Reference Card Sheet – This is the template Section Corner Reference Card 

Model. 

2.3-3  Creating Reference Boxes 
The following steps go through the process of creating a model containing the control point reference 
box for use in either Route Plat Sheets or the Section Corner Reference Card. 

1. Open your Des #_SRxx LCRS Plat.dgn from ProjectWise. 
2. As shown in the previous section, open the Models dialog from the toolbar icon. 
3. On the Models dialog, double click on the Point Number model to open it. 

 
The Point Number Model 

4. Select the Copy Model icon from the Models dialog. 
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Copying a Model 

5. The Point Number model has active field as shown in the earlier capture (the gray shaded areas 
for Point Number and Description).  During the model copying process, you will be prompted to 
create the new model with a new name and description.  The values for point name and 
description should be entered as you would like them to appear on the completed control point. 

 
Point Number Model Copy 

6. Once the model information has been entered, select OK.  The completed model copy will 
become active and will show the name and description in the control point as shown.  Repeat 
steps 4 and 5 for each additional reference box you require. 
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Completed Point Number Model Copy 

7. Next, the control point content needs created.  If not active from the previous steps, enter your 
control point model by double clicking on its listing in the Models dialog.  Once in the 
appropriate model, open the INDOT Tools workflow in MicroStation, and locate the Survey tab: 

 
Survey Tab in INDOT Tools Workflow 

8. First, you will add the north arrow.  Load the Survey Symbols library from the Survey Topo 
Symbols tool. 
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Survey Symbols 
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9. This will load the Survey Cell Selector.  On the displayed panel, locate the cell called northsy.  Do 
not use northsymb as it is scaled differently.  Clicking on the northsy button will bring up the cell 
placement tools at the appropriate scale.  Place the cell in the correct spot in the control point 
border.  Note that cells are sorted by letter case then alphabetical order.  (PSSA would show up 
in the list before northsy as the capital P takes precedence) 

 
The Survey Cell Selector 

10. Next locate the cells for the traverse station cell (PSSA) and any other object that needs placed.  
In each of these instances, a scale of 1 should be used.  Snap this cell to the center of the 
provided centerline. 

  
PSSA Cell Placement 
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11. After placing additional cells such as power poles (PPWP), you will need to place the lines for the 
dimension ties.  From the Quick Tools group in the Survey Tab, select the Place Line tool. 

 
Place Line 

12. While in the place line command, you will want to snap your initial point to the center of the 
PSSA symbol on the centerline. 

 
Drawing Dimension Ties 

13. Next, in your AccuDraw toolbar/window, place your cursor in any of the fields and hit the “M” 
key to set it to angular mode.   

 
AccuDraw Angular Mode 



 105 

14. Place your cursor in the angle field and enter the appropriate value.  This will also lock the 
angular value in allowing you to draw the line along the bearing you have specified.  Remember 
to specify degrees, using the ^ symbol (shift key + 6). 

 
Dimension Tie 

15. With the lines drawn, you can now adjust the placement of any cells that you’ve placed, and 
your resulting reference box should look similar to the following: 

 
Reference Box 
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16. Next, you will need to add the text labels to the Reference Box.  Start by selecting the Place Text 
tool from the Quick Tools Group on the Survey tab. 

 
Place Text 

17. With the Text Editor dialog now active, first set your Text Style to 10 Point Text.  This will initiate 
the appropriate justifications and sizes.  Due to the constrained size of the reference boxes, you 
will adjust your font to the Bentley WORKING font as shown.  Expand the dialog by clicking on 
the arrow in the font selection dropdown in the upper right-hand corner and select WORKING. 

 
Place Text Settings 

  



 107 

A Note on Text Styles 

As shown in the previous steps, you are deviating from the standard font applied to the 10 Point Text 
style, which will cause your text styles to become out of sync with the dgnlib.  To revert your text style 
to the appropriate values, you can reset the style from the Text Styles dialog (indicated by an ellipsis 
icon) located next to the text style selection box.  When you locate the style that no longer matches (it 
will be denoted with a blue font), right click on it and select “Update from Library”. 

 

 
Update from Library 
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In addition to adjusting the font, it may also be desirable to adjust the Justification options to more 
appropriately place your text along, above or below elements.  You can revert to the default text style 
settings by selecting the Reset option on the menu shown above. 

More Notes on Text Placement 

Various notes may require the use of special characters not directly accessible via the keyboard, such as 
the degree symbol.  There are two ways to place this and other symbols.  The first method is via the 
Insert Symbol button on the Text Editor.  Selecting this button will bring up the Symbol Inserter dialog.  
Via this dialog, you can find either place a symbol from the Favorite Symbols tab or you can use the All 
Symbols tab to search for the symbol you want (available in your selected font).  Then you can insert it 
into your text and quickly add it to the symbols favorite list. 

 
The Insert Symbol Tool 

 
The Symbol Inserter Dialog and Adding to Favorites 
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Additionally, if you know the appropriate key-in sequence, you can type the symbol in.  In the case of 
the degree symbol and the Working font, you can type it in by holding down the ALT key, then typing 9 
then 4.  This will place a ^ in the text editor, however when going to place the line of text, a degree 
symbol will appear. 

18. After placing the appropriate labels, your reference box should look like the following. 

 
Reference Box with Labels 

19. Finally, you need to place the note describing the monument type.  Like the Place Text tool, you 
will need to start the Place Note tool.  This tool can also be found in the location mentioned in 
step 16. 

 
Place Note 
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20. With the place note tool active, set the Dimension Style to Engr Arrow as shown. 

 
Place Note Settings. 

21. Next, on the Text Editor, change your active font from Tahoma to the Bentley WORKING font, 
and make sure the text style is set to 10 Point Text. 

 
Setting the WORKING Font 
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22. With the Place Note tool configured, type the monument information into the Text Editor.  
When the text is typed, place your cursor on the monument in the reference box and select the 
location where you would like to start the terminator.  A second placement will determine the 
leader length and direction and place the text box.  The resulting reference box will appear as 
follows: 

 
Completed Reference Box 

23. At this time, you may need to restore your text and dimension settings to their default 
configuration.  These steps are noted in tips throughout this section and are similar for text and 
dimension styles.  With this first reference box created, you can now create additional reference 
boxes for each point in the plat. 

2.3-4  Creating the Reference Point Coordinate Table 
Since the coordinates for the Reference Points are no longer contained in the Reference Box, a 
Coordinate Table will need to be created.  It is recommended to create one overall coordinate table for 
the Route Plat. The following steps go through the process of creating a Coordinate Table. 

1. As with the reference box, you are going to use the Models dialog to copy the template model 
included in the .dgn file.  Open the Models dialog and copy the Coordinate Table model. 

 
Copying the Coordinate Table 
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2. With your table copied, make sure the new model you created is active.  If not, double click on it 
in the Models dialog to activate it. 

3. All the text in this table is editable via the standard text editing tools in OpenRoads Designer.  
Using either the Edit Text tool, or by double clicking on the pieces of text, edit the values for 
your coordinate table accordingly. 

2.3-5  Adding the TOPO to the Routeplat Sheet 
With the reference boxes and coordinate tables created, you can now begin the process of creating the 
route plat sheets and populating the file with content. 

1. As in the previous two examples, take the template routeplat provided in the .dgn and copy it to 
a new model. 

 
Copying the Plat Model 

2. If not opened automatically, double click on your newly created model to activate it.  Should you 
need additional plat sheets, repeat step 1 as needed. 
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3. Now that a new routeplat model is created and opened, you can begin adding the various pieces 
of content.  When first entering the new routeplat model, you will see the following template 
information: 

 
The Template Routeplat 

As you can see in the preceding illustration, the template contains the appropriate border file 
and a grayscale border all in a sheet model (denoted by the virtual paper size around the 
border). 

4. You are now ready to begin adding content to this file.  Most of the content being added will be 
via OpenRoads Designer references.  Open the Reference dialog from the Primary Group of the 
Home tab. 

 
OpenRoads Designer References 
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5. The first item to attach is the topo drawing that has been created for the project.  Start by 
selecting the Attach Reference button from the Reference dialog. 

 
Attaching References 

6. Unlike the prior version of the referencing procedures, all the content resides in a single survey 
fieldbook DGN.  As such, when prompted for the file you would like to attach, select your single 
topo drawing as shown.  Make sure to set the attachment method to Interactive so you can 
adjust the scaling and view orientation. 

 
Reference Attachment 
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7. With your topo selected, select OK and configure the additional settings for your attachment.  
The following illustration shows the attachment made at 1”=100’.  Please note that on this panel 
that Coincident-World is selected as the Orientation. 

 
Attachment Settings 

8. With the attachment set to Coincident - World, the topo will not appear within the border.  As 
such, you need to move the topo back into the border.  Start by zooming extents, and then in 
the References dialog box, choose all the attached reference filenames you want to move, and 
select the Move Reference button. 

 
Move Reference 
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9. Left click at the location in the drawing you want to move the files from and then left click at the 
location in the drawing you want to move the files to.  This will move all the selected files to the 
new location. 

10. Be sure to save settings by hitting Ctrl + F, or selecting File -> Save Settings.  This will ensure that 
the changes you made to the reference files will be saved for next time. 

11. If you need to clip the reference, the easiest way is to use a fence.  Select the Fence tool from 
the Home tab of the Survey workflow. 

 
Place Fence 

12. On the Place Fence tool, make sure your Fence Mode is set to Inside.  In most instances, you can 
leave the Fence Type set to Block, however it may be advantageous to use one of the other 
fence methods to achieve a tighter clip around your topo. 

 
Place Fence Tool Settings 
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13. With your fence placed around your topo, you now need to select Clip Reference from the 
References dialog as shown.  On the Set Reference Clip Boundary dialog, make sure the Method 
is set to Active Fence.  When satisfied with the boundary fence you’ve defined and the clipping 
settings, left click in the drawing area to accept the clipped reference settings. 

 
Reference Clipping 

Note: You could draw a polygon and change its Class to Construction.  Then by changing the Fence Type 
to Element you can create the fence by selecting the polygon.  This would give you a way of recreating 
the same clip area for additionally attached reference files. 

14. Be sure to save settings by hitting Ctrl + F, or selecting File -> Save Settings.  This will ensure that 
the changes you made to the reference files will be saved for next time. 
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2.3-6  Adding Reference Boxes to the Routeplat Sheet 
Now that the topo has been added to the route plat, you need to add the reference boxes to the sheet.  
Continuing from the previous set of steps, make sure that you are in the appropriate Plat model; 
otherwise open it via the Models dialog as noted in step 2 of the previous section. 

1. With the plat sheet showing in the MicroStation view, you should see the frame of your topo 
and a dashed grid setup in the sheet.  If you do not see the dashed grid, it needs to enabled with 
the following steps. 

 
Routeplat with Topo and Grid 

2. If the grid is not visible, enable the Constructions option on the View Attribute panel.  This panel 
can be found on the View toolbar. 

 
View Attributes 
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3. The Constructions item can be found on the left side of the panel.  Make sure it is highlighted as 
shown in the following capture: 

 
Construction Elements Enabled 

4. At this time, you want to open both the Models and References dialog boxes from the Home tab 
of the Survey workflow: 

 
Models and References 
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5. With both the References and Models dialogs open, you can now drag the Reference Box 
models from the Models dialog and directly attach them to the Plat as references.  Note that 
you can drag and drop multiple references boxes at the same time on this dialog.  For this 
example, you will only be attaching a single reference box. 

 
Reference Box Attachment Drag and Drop 

6. Upon completion of the drag and drop, you will be prompted with the Attach Source Files dialog 
requesting you to adjust the alignment of the references being attached.  For the reference 
boxes, you want to use the Top attachment method as shown: 

 
Attach Source Files 
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7. After accepting the attachment method, you will see an outline of the reference extents that 
you are trying to attach.  Note that the attachment point is the center of the reference. 

 
Reference Attaching 

8. You need to position your cursor and snap to the appropriate grid location where you would like 
to place the reference box.  When satisfied with your location, place the reference by a left click. 

 
Placed Reference Box 

9. Repeat steps 5-8 for each successive reference box.  Finally, to disable the reference grid, 
disable the Constructions view attribute that you enabled in step 3. 
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2.3-7  Adding the Coordinate Table to the Route Plat 
Next, you need to add the Coordinate Table to the plat sheet. 

1. If not open and active, open your route plat and make sure the plat sheet is open in OpenRoads 
Designer. 

2. Make sure you have fit the entire sheet in your view.  Do this by either performing a Fit View 
Zoom from the View toolbar or by double clicking your middle/mouse button. 

 
Fit View 

3. At this time, you want to open both the Models and References dialog boxes from the Home tab 
of the Survey Workflow. 

 
Models and References 

4. With both dialogs open, you can now drag the Overall Coordinate Table model from the Models 
dialog and directly attach it to the Plat as a reference. 

 
Attaching the Overall Coordinate Table 
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5. When prompted with the Attach Source Files dialog, set your attachment method to Coincident. 

 
Coincident Attachment 

6. This will attach the coordinate table to your routeplat sheet.  You can adjust this reference 
placement by highlighting it on the Reference dialog and selecting the Move References tool 
and moving the reference as you would any other element. 

 
Move References 

2.3-8  Creating Section Corner Cards 
This section will walk you through the creation of Section Corner Cards and attaching the appropriate 
reference boxes. 

1. Make sure your route plat file is open.  You do not need to be in a specific model. 
2. Open the Models dialog.  As you have done in previous examples, you will be copying the 

template Section Corner Reference Card Sheet model as you did with both the reference boxes 
and the plat sheet. 

 
Accessing the Models Dialog 
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3. With the Models dialog open, highlight the Section Corner Reference Card Sheet model, then 
select the Copy Models button from the toolbar. 

 
Copying the Section Corner Reference 

4. In the Copy Model dialog, type the name and description of the reference card as shown in the 
previous illustration and hit OK.  This will copy the model and should open it in the OpenRoads 
Designer session.  If it does not open automatically, switch to it by double left-clicking on the 
model in the Models dialog. 

 
Section Corner Card with Reference Box 

5. Open the References dialog.  You will find that this model already has a reference back to the 
blank Point Number model in your active file.  This is pre-attached to appropriately place the 
reference and allow you to quickly select the appropriate point number attachment. 
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6. In the References dialog, double-click on the reference with the Model named Point Number 
and when prompted, change the model on the Attachment Settings to the appropriate 
reference box as shown. 

 
Adjusting Reference Box Attachments 

 
Reference Box Attachment 

7. At this time, you may conclude filling in the fields on the reference box and moving the section 
corner elements as needed.  To edit the text, use the Fill In Single Enter-Data Field tool found in 
the Text Group under the Drawing Production tab of the Survey workflow. 

 
Editing Section Corner Fields 

8. Repeat the previous steps for each reference box as needed. 
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2.4 Exporting/Reporting OpenRoads Survey Data 

Using the built-in survey processing and display tools, reporting can be far more specific--down to the 
feature level—when compared to the previous reporting functionality with using InRoads.  This section 
will look at two different export methods:  direct export to .csv and usage of the OpenRoads reporting 
tools. 

Please keep in mind that these methods are not a way to directly export data to a ready-made format 
and are more akin to a direct coordinate export.  Any output that these methods produce may need 
some clean up and modification if the intention is to use the data these provide in other ways. 

2.4-1  Reporting on Survey Information 
The following steps look at how to turn OpenRoads survey information into a reported format like those 
provided in SS2.  This example will show reporting on Point Features. 

1. With your DGN open, navigate to the Survey section of the Project Explorer.  Locate your 
fieldbook. 

 
Survey Fieldbook 
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2. Locate the ALL Point Features list under the fieldbook entry.  In the Primary section of the Field 
Book tab, select the Details tool. 

 
Survey Details for All Point Features 

3. This will bring up the Survey Details for all the points.  Should you wish to only report on a 
certain feature, or subset thereof, you can continue to drill down under the All Point Features 
on the Project Explorer to the feature you’d like. 

 
Survey Details 
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4. On the Survey Details display, you can select as much or a little, as necessary.  This dialog 
adheres to standard Windows conventions of Ctrl-click and Shift-click methods to select 
multiple entries either one at a time or in a sequence.  For this example, all points have been 
selected by using the Ctrl+A (select all) command. 

 
Selecting All Points 

5. With your points selected, right click on the far-left hand column (to the left of the point names, 
the upper left box will not work), and select Report on selected items. 

 
Report on Selected Items 
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6. This will start the Bentley Civil Report Browser and initialize the SurveyPointsCompleteTable.xsl. 

 
Survey Point Feature List Report 

7. You can then save the output to several formats, along with printing it to a printer or PDF file.  
Additionally, by right-clicking on the report background, you can bring up a context menu that 
allows you to export the format directly to Excel.  NOTE:  To have the table exported correctly to 
Excel, you must perform a right-click in the area containing the point feature information.  Then, 
select the Export to Microsoft Excel from the menu. 

 
Export to Microsoft Excel 



 130 

By exporting to Excel, you will get a tabular file with all the data in the report shown in their appropriate 
columns.  This will allow for the data to be quickly adjusted, and then if needed, saved to a .csv or other 
needed formats. 

 
Exported Point Feature Information 

2.4-2  Direct Export 
The steps for this process are like those in the previous section.  Perform steps 1 through 3 as explained 
in the previous section. 

1. To export the points directly out without reporting, you’ll right click on the upper left-hand cell 
in the table (to the left of the Name field header).  Select the Export option shown. 

 
Direct Export 
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2. You will be presented a Save As dialog.  Selecting the Save as type field will present the different 
options you can save your file out as. 

 
Exporting File 

Depending on the format chosen, you can then open the file either directly in Excel, a text editor, or 
several different applications. 
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3. Plans Production for Design in OpenRoads Designer 
The following sections discuss the usage of OpenRoads Designer for INDOT Plans Production purposes.  
The same federated approach to the drawing composition process that is recommended by Bentley will 
be used.  These sections discuss how the drawings are created, layered, and pieced together to form a 
fully realized data set that can then be turned into a plan set. 

3.1 Referenced Base Drawings 

As previously mentioned, a layered drawing process allowing for maximum flexibility in configuring data 
to be displayed, referenced, and reused is employed.  The base drawings for all these steps can be easily 
referenced together.  The only possible difficulty might be differences in coordinate systems between 
the files.  This may be resolved using OpenRoads Designer tools.  This problem is not likely unless you 
have drawings (OpenRoads Designer, MicroStation or AutoCAD) with information from sources outside 
of INDOT.  Despite this problem, it can be fixed.  The following figure displays how base drawings are 
placed together. 

 
 

Conceptual View of Base Drawings Referenced Together 

Note: With the combination of the Survey TOPO and Terrain model information being in a single DGN, it 
is no longer necessary to create discreet contour drawings.  The following workflow will describe the 
process of acquiring and using this data for your project. 

The above figure displays a view with the PrPlan dgn set as the active drawing and with the Survey 
Fieldbook dgn referenced into PrPlan. 

  

 

Base drawing Survey Fieldbook  

Base drawing PrPlan 
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An example illustrating this concept would look like what is shown below: 

 
PrPlan with Survey Fieldbook Referenced 

3.2 Introduction to Named Boundaries 

New to OpenRoads Designer is the concept of named boundaries.  Simply put, named boundaries help 
define the plotting extents of your design content.  This section will give a brief introduction to named 
boundaries and their application in creating plan sheets. 

Users can refer to Section 3.6 of this document for more detailed information about named boundaries 
and how to create them. 

3.2-1  Named Boundaries for Plan and Profile Views 
From the perspective of plan and profile views, named boundaries set the plotting extents for use in the 
creation of plan-profiles, bridge layouts, construction details, and other drawings.  All content—
including content from references—that is displayed within the named boundaries will show through on 
the sheets created from them.  The following figure displays an example of how named boundaries will 
display content from referenced base drawings: 
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Base Drawing Referenced into an Active Drawing with Named Boundaries 

The above figure displays a view with PrPlan set as the active drawing and a Survey Fieldbook 
referenced as a base drawing. 

Each of the named boundaries represents a plan view area that is clipped into a given plan profile sheet.  
This same concept also applies to the profile view area of these sheets.  Other drawings—such as 
Construction Details and Bridge Layouts—use these same principles, but with different view sizes and 
layouts for each, depending on the desired sheet type and scaling. 

3.2-2  Named Boundaries for Cross Section Views 
In the context of cross sections, named boundaries define the extents of each of the individual cross 
sections.  It is important to note that the named boundaries for cross sections are “live” snapshots, in 
that they will update automatically based on the content they interact with.  For example, say there is a 
proposed change to the vertical profile of an alignment.  The design content contained within the cross 
section named boundary will change automatically to accommodate the profile change. 
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Cross Section Before Profile Change 

 
Cross Section After Profile Change 

Note that in this specific scenario, you would have to remove and reapply the drawing model 
annotations to update the profile grade annotation.  You can refer to section 4.1 of this document for 
instructions on working with these annotations. 

3.3 Drawing Models 

As of the release of OpenRoads Designer, the plans production process directly incorporates the use of 
drawing models.  Drawing models are created using named boundaries to show a snapshot of the 
contents of the design model that reside within them. 
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3-D View of Cross Section Named Boundary 

 
Drawing Model Containing the Cross Section Named Boundary Shown Above 

The Named Boundary tool in OpenRoads Designer—explained in further detail later in this chapter—
automatically creates drawing and sheet models for Plan and Profiles, Layouts, Construction Details, and 
other types of sheets.  The drawing models reference in the named boundaries that are created from 
the design model, and then have the desired annotation applied to them.  These finished drawing 
models are then referenced into the sheet models in conjunction with the appropriate border file. 

A very important aspect of drawing models to keep in mind during the plans production process is the 
relationship to their corresponding design models when it comes to the display of your design.  As 
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explained above, drawing models reference in the named boundaries that are created from the design 
model.  Taking it one step further, sheet models then use these drawing models as references and place 
them within a specified sheet border.  How the design elements are displayed in the drawing and sheet 
models is controlled by two different reference attachment settings: one in the sheet model, and the 
other in the drawing model.  These settings will be explained in the following two sections.   

3.3-1  Display Overrides Setting 
The first reference attachment setting that controls the appearance of design elements in sheet models 
is the Display Overrides setting.  This setting—set for the drawing model attachments to your sheet 
model—controls how nested references (i.e., design models) are displayed in your active sheet model.  
Per the request of our Design group, we have set this setting to the Always option by default in all of the 
preconfigured sheet seeds that CAD Support makes available.   No additional action is required by users 
for this setting. 

 
Always Display Overrides Setting in Drawing Model Attachment to Sheet Model 

What the Always option enforces is that no matter what changes you make to the display settings in 
your direct attachment (i.e., drawing model) for your nested attachment (i.e., design model), those 
setting changes will be ignored in the sheet model.  In other words, whatever display settings are set 
directly in the sheet model for the design model will be honored regardless of any display settings that 
are set in the drawing and/or design models. 

3.3-2  Synchronize View Setting 
The other reference attachment setting that controls the display of design elements in sheet models is 
the Synchronize View setting.  This setting—set for the design model reference attachment in your 
drawing model—controls how the drawing model processes display changes to the referenced design 
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model.  To access this setting, open up a drawing model in your file and then open the References 
dialog.  From there, open up the Properties dialog for the attachment, which in this case would be your 
design model.  Note the Synchronize View setting as shown below: 

 
Synchronize View Setting 

For the purposes of plans production, there are different options for this setting that need to be used—
depending on the type of drawing model you are working with. 

• If you are working with a drawing model of a plan view, the Settings from Design Model option 
(as shown in the example above) is the appropriate one to use—as it will recognize any display 
changes to the design model and cascade them down to the drawing and sheet models 
accordingly. 

• If you are working with a drawing model of a profile view OR a cross section view, the 
appropriate option to use is the Volume Only option.  This is per guidance from Bentley, as it 
was discovered that the Settings from Design Model option produced erratic results for these 
drawing model types. 
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Volume Only Option for Synchronize View Setting 

NOTE: The Synchronize View setting ultimately overrules the Display Overrides setting when it comes to 
controlling your display.  For example, when you have the Settings from Design Model option set for the 
Synchronize View setting, it for all intents and purposes ignores the Display Overrides setting in the sheet 
model, and all display changes would have to be made in the design model. 
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3.4 Creating Base Drawings 

With the move to OpenRoads technology, several changes have been made to the base drawing 
process.  The most obvious change is that some of the supplemental files that were used by InRoads are 
no longer necessary for the creation of the base sheets—particularly the DTM file (surface).   

As the DTM content has now been split into various data containers within the DGN, there is some 
additional flexibility that has come about.  First, contours and triangles are no longer separate drawing 
steps.  Instead, they are displayable portions of the terrain model that can be enabled/disabled with a 
toggle.  Additionally, as the DGN is now the container, standard MicroStation referencing can be used to 
make data available across files. 

This section looks at creating comparable base drawings to how processes in the past have compiled 
them.  This allows us to maintain a vast majority of the current workflow while maintaining flexibility in 
providing the base data across the project.  In that regard, the biggest change is that a drawing for 
existing contours will no longer be created separately. 

Next, a note on scaling.  OpenRoads tools are no longer dependent on a specific scale being assigned at 
the time they are drawn and are now using Drawing Scale instead.  This allows for the scaling of data to 
be done on the fly as discussed in Section 1.5-5 of this document.  For the purposes of this document, 
CAD Support will continue advocating that—if possible—a scale be given to the file.  Should multiple 
scales be unnecessary, the omission of the scaling will be acceptable (ex. PrPlan 50.dgn becomes 
PrPlan.dgn).   

As a reminder and reinforcement from the previous sections, please pay special attention to the seed 
files that are recommended for use throughout this chapter.  Geometry elements drawn in a 3D seed file 
will cause issues with cross section generation even after a vertical profile has been applied.  As such, it is 
very important that content is placed in the right file to eliminate potential issues. 

3.4-1  Geocoordinating Base Drawings 
Depending on the methodology used to start your base drawings, you may opt to start from fresh seed 
files.  The following documentation assumes the usage of already provided files that will be preset with 
the appropriate geocoordination information.  This section, however, covers the process of 
geocoordinating individual files and may not apply/be necessary in all workflow situations. 

One can easily geocoordinate a DGN file through the following process in a regular OpenRoads Designer 
session. 

Note: Moving into OpenRoads Designer 2023, Survey Foot based Geographic Coordinate Systems have 
been incorporated into the platform and will be available with newly created data.  The dialog covered in 
step 5 below, will only be shown if the ProjectGCS from a legacy project is being used or the coordinate 
system is imported from a file created from the legacy Metric coordinate systems.  These systems are 
compatible, and project data can be a mix of the Survey Foot and legacy Metric systems with no impact 
to geospatial relationships between CAD files.  All other spatial data such as imagery or imported GIS 
data will reproject as necessary between the coordinate systems without issue as well. 
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1. In OpenRoads Designer, go to the Geographic tab of the Survey workflow, and select the 
Coordinate System tool. 

 
Coordinate System Tool 

2. On the Geographic Coordinate System window, select the From File option. 

 
From File Option 

3. This will present a ProjectWise file browser.  Navigate to your Survey/Project Files folder and 
select the Des #_SRxx Seed 3D.dgn or the 2D version. 

4. With the .dgn highlighted, select Open and the geocoordinated definition for the selected file 
will be imported into your active DGN. 

5. A pop-up dialog may appear asking you to choose whether you want to reproject the data based 
on this newly applied coordinate system.  Be sure to select the option to keep the storage units 
as they are (should not be changed) as shown below. 

 
Keeping Storage Units 
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3.4-2  Creating a Geometry DGN/PrPlan 
Corridor modeling in OpenRoads means that alignments must exist as information within a civil model 
instead of part of an ALG file.  The expectation for projects surveyed in OpenRoads is that a Des #_SRxx 
Survey Alignments.dgn will be provided as part of the project.  As with the other survey deliverables, 
this file and content will be geocoordinated and based off the provided Des #_SRxx Seed.dgn that’s part 
of the survey project. 

Please keep in mind that whether you have a survey provided alignment in a DGN or ALG, the model 
with the alignment in it should be a 2D file, or if creating from legacy data, based on the provided 2D 
seed file for your project. 

As it pertains to the horizontal alignment itself, it should be created with the Horizontal toolset on the 
Geometry tab of the OpenRoads Modeling workflow. 

 
Horizontal Geometry Tools 

Also, when creating the horizontal alignment, be sure to set it to the appropriate horizontal alignment 
feature definition. 

 
Setting the Horizontal Alignment Feature Definition 
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For the purposes of this example, you will be looking at keeping a separate DGN file for the alignment 
information and then creating the model and terrain in the PrPlan XX.dgn, which you will create later. 

To create the file, you can use the process outlined in section 2.2-1.  For this file however, your base file 
will be Des #_SRxx Survey Alignments.dgn.  With this file created and named Design Alignments.dgn, 
you can then proceed with modifying your survey alignments or creating additional alignments.  Again, 
with the ability to reference the DGNs together to share the civil data, this alignment file can then be 
attached as needed for the purposes of corridor modeling. 

3.4-2a Drawing the Proposed Profile to the Design Alignments.dgn 
Moving to OpenRoads technology requires a new mindset when it comes to working with profiles.  In 
InRoads, all profile work was used drawing directly on top of profile graphics in your base drawing file.  
This was possible as the ALG file was portable across any file that was open with InRoads.  Due to the 
change of how an alignment is stored, you will look at the process of creating a profile using the 
OpenRoads Designer tools in preparation for plans production.  This example will assume that you are 
starting with a Des #_SRxx Survey Alignment.dgn file that you have copied and renamed to Design 
Alignments.dgn. 

Please keep in mind that this file should be 2D in nature.  A 3D model will be automatically created by 
the software and is reference attached as soon as a terrain is referenced and made active and when a 
vertical profile is being displayed.  OpenRoads Designer will automatically generate the 3D geometry 
elements from the 2D information. 

To create a profile display in OpenRoads Designer: 

1. From the Geometry tab of the OpenRoads Modeling workflow, select Open Profile Model from 
the Vertical group.  Alternatively, you can locate this tool by highlighting the alignment and 
selecting the tool from the heads-up display when hovering over the alignment. 

 
Open Profile Model 

2. If selected from the Task Navigation panel, the tool will prompt you to first locate the plan 
element.  Select the plan view representation of your alignment. 
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3. With the alignment selected, OpenRoads will then prompt for a view to be selected or opened. 

 
Select or Open View for Profile 

4. Use the View Groups toolbar to open an additional view.  Any of the views from 2 through 8 are 
acceptable.  Left click in the opened display to confirm the profile creation.  Note that the tool 
will redisplay in any view you select potentially erasing any data displayed.  In the event you 
overwrite a profile display, know that only the graphics are lost.  The actual alignment 
information will persist as part of the civil model. 

 
Profile Display 

Note: In the previous version of InRoads, it was necessary to manually select the feature that the existing 
surface was on to have it display properly in profile.  In OpenRoads Designer, this is no longer necessary 
as the terrain model uses the same feature for the boundary and profile display. 
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With the existing profile now displayed, you can proceed to creating a proposed profile.  Please keep in 
mind that this profile display is not actually part of the base model in the DGN itself; rather, it is a 
dynamic view that allows for the creation of the civil data that makes up the profile. 

3.4-2b Adding the Proposed Vertical Alignment 
With the profile now displayed in its own view, you can now begin placing the elements that will be used 
for the vertical profile.  For this process, you’ll continue to use the Vertical toolset in the Geometry tab 
of the OpenRoads Modeling workflow. 

 
Vertical Geometry Tools 

Note that when creating your vertical alignment, be sure to select the appropriate P_ALG_Horizontal 
alignment feature definition from the Alignment category as shown below. 

 
Selecting Vertical Alignment Feature Definition 

NOTE: CAD Support is aware of the potential confusion of the current naming convention of the 
“Horizontal” feature definitions specified above.  As such, for the next ORD workspace release we will 
change the naming convention for the feature definitions in the Alignment category to remove the 
unnecessary distinction between horizontal and vertical. 
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3.4-2c Creating 3D Cut Sections in Profile Models 
There may be situations where you’d like to show crossing features along your profile model.  This can 
be accomplished with the Create 3D Cut tool on the toolbar of the profile model. 

 

Location of Create 3D Cut Tool on Profile Model Toolbar 

The process to use this tool is as follows: 

1. In your profile model, select the Create 3D Cut tool.  
2. You will be prompted for a placement method for the 3D cut.  There are two options: Corners 

and Full Profile.  The Corners method lets you define a rectangular area along your profile that 
you want the 3D cut to be performed.  The Full Profile method automatically makes a 3D cut 
along the entire profile with no real flexibility for location, settings, etc.  For the purposes of this 
example, we will demonstrate the Corners method, as it provides more flexibility. 

 

Placement Method Options for 3D Cut 

3. With the Corners method selected, left-click to confirm the selection.  You will then be asked to 
provide a start point for your 3D cut section.  It would be most beneficial to have both your plan 
and profile views displayed simultaneously, as you are provided a visual cue in both views to 
show you the horizontal location of where you are placing the points.  In this example, we will 
create a 3D cut section in the vicinity of a pipe that is crossing the alignment.  The exact location 
of this point is mostly arbitrary.  The only real requirement is that the start point occurs before 
the object you want to cut through.  Left-click to confirm the placement of the start point. 
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Location of Start Point for the 3D Cut 

4. With the start point selected, you will then be asked to locate the end point of the 3D cut 
section.  As with the start point, the exact placement is mostly arbitrary.  The only requirement 
is to be sure that the end point of the cut section would completely cut through the object 
you’re wanting to display.  Left-click to accept the placement of the end point. 
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Location of End Point for the 3D Cut 

5. A 3D cut section should now be placed in your profile model, with your crossing feature included 
within it—which in this case, is a pipe. 

 

3D Cut Section in Profile Model (with Crossing Feature) 
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Creating 3D Cut Sections in a Profile Model for Features that Don’t Cross the Mainline Alignment 
There may be situations where you would like to show a crossing feature in your profile that does not 
cross the mainline alignment itself.  To demonstrate this, we will use the example scenario shown below 
with a pipe that doesn’t cross the mainline. 

 

Crossing Feature that Doesn’t Cross Mainline 

For this scenario, you would create the 3D cut section like you normally would.  However, since the pipe 
does not cross the mainline alignment, the cut section will not initially show the crossing feature in the 
profile model. 

 

Initial 3D Cut Section 



 150 

To show the crossing feature in this scenario, select the 3D cut section itself in the profile model, and 
note its Properties.  Locate the Cut Offset property under Clip Volume. 

 

Cut Offset Property of 3D Cut Section 

The Cut Offset property defines the horizontal (left/right) offset along the alignment where you would 
like the 3D cut to be performed.  In this example, since the pipe is to the left of the alignment, we will 
provide a negative value for the offset.  As such, we will enter a value of -1 foot for this property. 

Once the Cut Offset property has been changed, you will need to select the Refresh 3D Cut tool in the 
profile model toolbar to update the display of the 3D cut section. 

 

Location of Refresh 3D Cut Tool in Profile Model Toolbar 

Upon clicking on the tool to activate the refresh process, the crossing feature is now displayed. 

 

Refreshed 3D Cut Section with Modified Cut Offset Property 
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3.4-3  Creating the Proposed Plan Drawing 
With the survey fieldbook and design alignments in separate DGNs, it is time to bring the base sheets 
together as preparation for plans production.  The following steps assume that the corridor model and 
proposed terrain have been created and are prepared to be attached to the proposed plan drawing.   

You can refer to section 3.4-1 for instructions on how to create a new document from a template seed 
file using the Advanced Wizard in ProjectWise.  Open the file once created. 

At this time, you can begin by referencing your Survey Fieldbook and Survey/Design Alignment DGN 
files. 

1. Open the References dialog from the Home tab of the OpenRoads Modeling workflow. 

 
References 

2. On the References window, select the Attach References button. 

 
Attaching References 
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3. Select both the Survey Fieldbook and Design Alignments DGN files.  This can be done by holding 
the Ctrl key on the keyboard while left clicking on each file.  Select OK when ready to proceed. 

 
Selecting the File to Attach 

4. As all files should be in the same coordinate system, the Coincident – World orientation setting 
should be used.  All other settings can be left to their default values.  When ready select the OK 
button. 

 
Attachment Settings 
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5. Repeat this process for all the files you are attaching. 
6. Finally, adjust your Drawing Scale to the appropriate value.  For this example you will be using 

1”=50’. 

 
References Attached and Displayed a 1” = 50’ 

As an alternative to attaching each file specifically, you could also use Live Nesting to attach Explan 
XX.dgn to the Design Alignments.dgn and then into Prplan XX.dgn.  Just make sure that the Nested 
Attachments are set to Live Nesting and that the depth is 1 or greater depending on your project needs.  
In that instance, your reference dialog may look like the following: 

 
Using Nested References 
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Civil Model with Nested References 

At this point you will have the required data to begin the corridor modeling process.  Upon completion 
of your modeling, you will be prepared to continue in Prplan XX.dgn. 

Corridor Modeling with Referenced Geometry and Terrains 
As discussed at numerous points throughout this document, OpenRoads allows for the separation of 
design items by placing them in separate DGN files and then referencing them back together.  While a 
very powerful tool to have, there are a few items to keep in mind while working with referenced 
elements. 

The first item to keep in mind is making sure you activate the terrain properly.  In the above example 
you have attached the Explan 50.dgn which contains the terrain model that will be targeted.  Prior to 
performing any modeling process, you must first make sure it is the active terrain model.  Unfortunately, 
it will not show up in the civil model dialog until activated.  To do so, hover over the perimeter of the 
terrain.  When the heads-up display appears, select the Set As Active Terrain Model option. 

 
Set As Active Terrain Model 
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With the terrain activated, your Civil Model tab will then populate with the referenced in information 
and look like the following: 

 
Civil Model with Active Reference Data 

At this point, a new 3D model will be created and referenced back in.  Please keep in mind the view 
control process from section 1.2-3 of this document as having both 2D and 3D views will be beneficial. 

Next, while modeling with referenced alignment information, know that you will not be able to 
graphically pick vertical profiles as they will not be able to be drawn up from a referenced file.  To 
further that, please keep in mind that the horizontal alignment and its vertical profile MUST reside in the 
same DGN file.  When creating a corridor, you will first select the plan view alignment.  On the following 
dialog requesting the Profile Element, select the appropriate vertical from the Locate Profile Element 
dialog. 

 
Selecting the Vertical Profile 
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With the terrain active, and the horizontal and vertical profiles selected, you can then proceed to create 
your corridor in Prplan XX.dgn 

Note:  One thing to be very careful about when working with referenced civil data is the detaching of 
references.  All civil data is based on an ever-evolving set of rules and connections to available data in 
your project.  Should you have civil data that is connected in this manner and then go to detach a file, 
you may see the following dialog. 

 
Civil Dependencies and References 

This message means that there are civil dependencies that exist with your data.  Special care should be 
used, and best practice is to avoid detaching references when possible, so as not to break any civil 
references. 

Finally, special care should be taken when specifying the Nesting Depth setting for your nested 
references.  Due to a known defect that CAD Support has brought to Bentley’s attention, entering an 
arbitrary high value for this setting—which we have suggested previously—could produce duplicated 
displays of your references in drawing models when you create your plan sheets.  At this time, we advise 
being judicious in choosing the right values that correctly encapsulate your nested referencing, as 
entering an arbitrarily high number could produce undesirable results.  If you do experience a 
duplication of your references when you create your plan sheets, you will likely need to adjust this 
setting to address the issue. 

With your design completed and being displayed over your existing terrain, you can now begin the final 
preparation steps for creating cut sheets. 

3.5 Adjusting your Design Stage for Plans Generation 

As you work on your design, much of the display control on your corridor will be via the use of the 
Feature Definition options in the corridor’s properties.  These feature definitions (which function in 
much the same way as “Design Stages” in previous versions of OpenRoads) are a combined set of rules 
that govern how your corridor is displayed and the level of accuracy which it is modeled. 

As you complete your design, you will notice that there are several different feature definitions that you 
can apply to a corridor: 

• 0 - Functional 
• 1 - Preliminary 
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• 2 - Design 
• 3 - Final 
• 4 - Final w/ Meshes 
• 5 - Final w/ Top Mesh 
• 6 - Final w/ Bottom Mesh 
• 7 - Final w/ Linear Features 
• 8 - Final w/ Components 

These options all allow for different representations of the corridor and how it displays in the plan view.  
While each of these have different uses, the 3 - Final feature definition is the one that will be used 
most—as it allows for the most thorough display of all corridor information.  However, this display 
setting contains far more information than is needed for plans generation: 

 
Corridor Using 3 - Final Feature Definition 

For the purposes of plans generation, most instances will need to display the final linear elements of the 
corridor.  The recommended Design Stage to display just this information is 8 – Final w/ Components.  
This corridor stage has been modified to display both the components and linear features allowing for 
the display of the components in cross sections. 
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Corridor Using 8 – Final w/ Components 

This is the most appropriate display for plans generation and should be used when displaying the 
corridor to cut plan sheets and cross section and will be reflected in the ModelName-3D that’s created.  
At this point you can control the display of any subgrade features by shutting the relevant levels off in 
the level display. 

3.6 Sheet Layout and Creation (Plan Profile Sheets) 

One of the major items that has been changed with the release of OpenRoads Designer is the use of 
named boundaries in the creation of sheet drawings. 

This section covers how to create the named boundaries themselves, and then how to create Plan and 
Profile sheets from them. 

Note: The INDOTWise 5.1 Workspace for OpenRoads Designer 2023 now has Workset functionality 
enabled.  This functionality allows for the use of the Workset Sheet Index, and sheets can be directly cut 
to the Index through OpenRoads Designer.  Please see Section 3.9 of this document for further 
information on using this functionality. 

3.6-1  Files Required for Plans Production 
Before beginning the process of creating plan sheets, make sure you have the following items created 
and set up properly: 

• Your survey fieldbook file with the terrain included. 
• Your Prplan XX.dgn (which references your survey fieldbook file) that contains your proposed 

design elements. 
• An alignment to create the named boundaries along.  The alignment can be created in the 

PrPlan directly, or it can be included in the PrPlan via reference. The alignment must also have a 
vertical profile associated with it. 
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• A blank geocoordinated 2D seed file.  This file is to be used as needed as the foundation for 
cutting your various plan sheets.   

3.6-2  Named Boundary Creation 
The first step in the creation of Plan and Profile sheets in OpenRoads Designer is to first open a blank 2D 
geocoordinated seed file and reference your PrPlan XX.dgn into it.  From there, you can adjust the 
necessary level and display settings within the file as desired prior to creating your plan sheets.  Then 
once your preliminary setup is complete, you can create named boundaries to determine the extents of 
your plan and profile sheet(s).  To accomplish this, separate named boundaries are created for the plan 
view and the profile view to create the sheet.  This section will cover how to create named boundaries 
for each view. 

Note: Once named boundaries have been created, they can be reused if further iterations of the sheets 
need cut.  Please see section 3.8-4c of this document for a discussion of this process in the context of 
cross section sheets.  The process described there is also applicable to other named boundary types used 
in the plans production process. 
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3.6-2a Creating Named Boundaries for the Plan View 
With a blank 2D geocoordinated seed file open, perform the following steps: 

1. Reference your PrPlan XX.dgn into the file.  This will bring in all your design information into the 
file. 

2. Before creating named boundaries and cutting your sheets, proceed to adjust the level display, 
presentation settings, etc. within the file as desired to have the plan sheets look the way you 
want when they are created. 

3. With the preliminary setup completed, navigate to the OpenRoads Modeling workflow, click on 
the Drawing Production tab, and then click on the Named Boundary tool. 

 
Named Boundary Tool 

4. The Place Named Boundary dialog will then appear.  Along the top, there are several options to 
choose from to create named boundaries.  In this case, select the first option: Civil Plan. 

 
Civil Plan Option in Place Named Boundary Tool 
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5. The first setting to configure is the Drawing Seed.  This setting contains several preconfigured 
drawing seeds that set the Detail Scale, Length, Left Offset, Right Offset, and Overlap values for 
the desired plan view.  Plan view options include those needed for Bridge Layouts, Double Plan, 
Plan Only, Letter Plan, and Plan and Profile sheets.  For this example, the Plan Profile (Plan) 30 
Scale drawing seed will be used. 

 
Selecting a Drawing Seed 

6. At this point, you can fill in the Name and Description fields for the Named Boundary: 

 
Name and Description for Named Boundaries 
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7. The next settings to fill in are the Name and Description fields for the Plan Group.  The Name can 
either be entered in manually, or by clicking on the path element (i.e., alignment) that you are 
placing the sheets along—which will automatically populate the Name field with the name of the 
alignment.  The Description in either case is optional.  Be sure to make note of the Name, as it 
will come into play when it comes time to create the corresponding named boundaries for the 
profile view. 

 
Name and Description for the Plan Group 

8. The next settings to address are the Start Location and Stop Location.  If not already selected 
from the previous step, select the alignment that you are wanting to create the sheets along.  
Once the alignment is selected, the Start Location can be chosen interactively anywhere along 
the alignment—which follows your mouse pointer as indicated by a gray line perpendicular to the 
alignment. 

 
Selecting a Start Location 
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Alternatively, click the button to the right of the Start Location field to lock it to the beginning of 
the chosen alignment.  A check mark will then appear to indicate that it is locked. 

 
Locking the Start Location to Beginning of Alignment 

9. In a similar fashion as selecting the Start Location, the Stop Location can be selected interactively, 
or by clicking on the button to the right of the field to lock it to the end of the chosen alignment. 

 
Locking the Stop Location to End of Alignment 

10. At this point, all the settings should be in place to create the Named boundaries.  The last 
remaining step is to disable/uncheck the Create Drawing setting—as at this point, you do not 
want to create the drawing yet without having your profile named boundaries defined. 

 
Disabling the Create Drawing Setting 
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11. To proceed with creating the named boundaries, click anywhere within the view to accept the 
Named Boundary settings.  The named boundaries (outlined in gray) will now appear in the view, 
and click again to accept the placement. 

 
Named Boundaries Created 

3.6-2b Creating Named Boundaries for the Profile View 
With the named boundaries created for the plan view, you are now ready to create the named 
boundaries for the profile view. 

1. The first step in the process is to display the profile of the alignment.  While still in the 
OpenRoads Modeling workflow, select the Geometry tab, and click on Open Profile Model from 
the Vertical group. 

 
Open Profile Model 

  



 165 

2. Select the alignment to get the profile for, open a new view to place the profile in (in this 
example, View 4), and click within the view to place the profile. 

 
Profile Placed within a New View 

3. With the profile placed in the new view, go back to the Drawing Production tab and open the 
Named Boundary dialog once again. 

 
Opening Named Boundary Dialog 

 

 

4. This time, select the third option: Civil Profile. 

 
Civil Profile Option in Place Named Boundary Tool 

5. In much the same fashion as for the named boundaries in the plan view, Drawing Seeds have 
been preconfigured for different profile preferences as well, including Bridge Layouts, Profile 
only, and Plan and Profile sheets.  For profiles, the Drawing Seeds preconfigure the Detail Scale, 
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Vertical Exaggeration, Available Profile Height, Top Clearance, and Bottom Clearance settings.  In 
this example, the Plan Profile (Profile) 30 Scale Drawing Seed will be chosen. 

 
Selecting a Drawing Seed 
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6. After the Drawing Seed is selected, note the Method and Plan Group settings. 

 
Method and Plan Group Settings 

By default, the Plan Group that is selected is the one that is associated with the most recently 
created named boundaries in the plan view.  The Method chosen by default is From Plan Group, 
which essentially sets the profile named boundaries to share the same station limits as 
specified for the selected Plan Group.  There is also a “Station Limits” method, which allows you 
to set specific start and end stations for the profile limits. 

7. In the same way as for the Plan Group, you can specify the Name and Description for the Profile 
Group. 

 
Name and Description for Profile Group 
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8. With the settings configured as desired, you are ready to create the named boundaries for the 
profile and create the Plan and Profile sheets.  Note these checkboxes at the bottom: 

• Use Terrains: Places the active terrain into the profile view of the sheet. 
• Use Active Vertical: Places the active vertical profile on the sheet. 
• Create Drawing: Enable to proceed with creating the Plan and Profile Sheets 
• Show Dialog: If enabled, will show a dialog with additional Drawing Seed parameters 

prior to sheet creation. 

For the purpose of this demonstration, all the above settings will be enabled. 

9. At this point, select the profile created in the secondary view (in step 2), and click once again in 
the profile view window to accept.  A Create Drawing dialog will then be displayed as shown: 

3.6-3  Completion of the Plans Production Process – Creating Sheets 

 
Create Drawing Dialog 

The Create Drawing dialog provides you with a chance to review the settings specified in the 
creating of the named boundaries in the plan and profile views.  In this case, the Plan and Profile 
mode should be selected, and in the View Name and Model Name fields, proceed to enter a 
different name if you would like to change the default naming given.  Then for the Annotation 
Group setting for the plan view, select the appropriate Plan annotation group.  In this case, you 
would select the Plan Profile 30 Scale annotation group by navigating to Plan  Drawing  Plan 
Profile 30 Scale.   
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Plan Annotation Group 

Finally, pay special attention to the One Sheet Per Dgn setting which, when enabled, will create each 
resulting plan and profile sheet to a separate dgn file.  What follows is the procedure going forward for 
each case (disabled vs. enabled).   

3.6-3a One Sheet Per Dgn Setting Disabled: 
10. When you are satisfied with the settings (One Sheet Per Dgn Setting disabled), click OK to create 

the drawings.  Note the two sets of files that get created: a set of Drawing models and a 
corresponding set of Sheet models. 

 
Newly Created Models 

In this example with two Plan and Profile sheets being created, two Sheet models are created that 
contain the Plan and Profile sheets, and four Drawing models: one Drawing model for each Plan view 
and Profile view, respectively.  These Drawing models are then referenced into the Sheet models to 
create the Plan and Profile sheets. 
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3.6-3b One Sheet Per Dgn Setting Enabled: 
10. If you wish to have the plan and profile sheets created and placed in separate dgn files, click on 
the checkbox to enable the One Sheet Per Dgn setting.  Then click on the folder icon to select a 
location in either ProjectWise or your local computer to save the files to. 

 
One Sheet Per Dgn Setting Enabled 

11. One final setting to consider is the Open Model setting at the bottom of the dialog.  If you do 
not wish to have your current OpenRoads Designer session ended when the sheet creation 
process is over, disable this setting.  Otherwise, the current OpenRoads Designer session will be 
ended, and the latest plan and profile sheet dgn to be created will be opened in its place. 

12. Once satisfied with all the settings, click OK.  The plan and profile sheets will then be created at 
the specified location (ProjectWise in this example).  NOTE: When initially created, the new dgn 
files will be associated with MicroStation by default.  To open these new files with ORD, you 
will need to modify the files’ properties such that it is associated with ORD instead of 
MicroStation. 

 
Plan and Profile Sheets Created in Separate DGN Files 
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3.7 Adding Other Base Drawings to Sheets 

Other base drawings such as Existing Right of Way can be added to OpenRoads created sheets such as 
Plan Profiles, Layout sheets, etc.  The user must first obtain right of way drawings from whatever 
sources are available.  For most projects, the existing right of way information will come from Route 
Survey Plat drawings and these should exist in the same coordinate system for any new projects and will 
line up automatically. (These are provided by your surveyor).  Other sources may include CAD drawings 
from Real Estate consultants (following complete abstracting and title searches).  Throughout this 
section, Existing Right of Way drawings are referenced as being created.  The same processes work for 
adding any additional information to the sheets. 

Depending on your surveyor, it is entirely possible that you may receive your Existing Right of Way in 
InRoads or OpenRoads Designer native surface features or as alignments.  Be aware you may still have 
to graphically convert either of these data types into the other for the purpose of cross section display 
(Right of Way must be a surface feature if you wish for it to display on cross sections). 

3.7-1  Combine multiple drawings into one base drawing 
If you have more than one existing right of way drawing for your project, you will want to combine all 
the drawings into one.  Reference the drawings into each other.  If the drawings do not line up 
automatically, you will need to move the files based on corresponding coordinates present in both 
drawings.  Next copy the reference files into the base drawing.  Repeat this procedure if you have 
multiple files to copy in. 

When you have completed the above steps, the desired result is one combined existing right of way 
drawing. 

3.7-2  Move to same coordinates system as PrPlan.dgn 
For the combined existing right of way drawing to be used in the plan profile sheets, the elements must 
exist in the same coordinate system.  To accommodate this, you will reference in the PrPlan drawing.  If 
the drawings do not line up automatically, you will need to move the files based on corresponding 
coordinates present in both drawings.   

The resulting existing right of way drawing is now ready to be added into other proposed drawings. 

3.7-3  Graphically Importing Existing Right of Way 
As the procedures necessary vary depending on the source of your Right of Way data, you will examine 
a few of the more common methods for importing this data and working with it in OpenRoads Designer 
and making it available to others. 

Data which is graphical in nature can be converted to a format OpenRoads Designer will interact with.  
MicroStation, AutoCAD, and DXF files are all supported for this process.  Utilizing the File import tools 
available allows vector graphics data to be converted to geometry or surface features.  Often-times the 
largest barrier to conversion is the sheer volume of data in the CAD file provided.  Disseminating the 
contents requires patience and organization. 

In both instances, be aware that the element must be drawn up graphically, as there is no direct 
translation method from Surface Features to Geometry Alignments. 
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3.7-3a Importing to Geometry 
Using an existing CAD file provided by either Survey or a Consultant, you will convert the vector graphics 
representing Right of Way elements to OpenRoads Designer geometry.  If the data provider is an INDOT 
employee, then the file is accessible through ProjectWise from the design folder structure.  Files 
provided by external consultants can be imported to a convenient location in ProjectWise by dragging 
and dropping.  Select No Wizard for the creation option.  

First you need to reference and possibly merge your data into the base drawing (alignments can be 
imported from reference elements).  Attach your file using the References tool from the Home tab of 
the OpenRoads Modeling workflow.  With the References dialog open, attach the file containing your 
right-of-way.  This may be the LCRS Plat provided by survey or another file provided by a consultant.   
Note that the file you attach may have additional data displayed that you do not wish to import.  Should 
this be the case, you can use your level display to disable the levels of features you do not wish to 
display. 

At this point, you will no doubt recognize the right-of-way elements in the drawing.  Elements can be 
converted to OpenRoads Designer geometry.  Careful inspections of right-of-way elements may show 
elements that have been constructed, segmented, and are not joined.  For convenience in later 
operations, you may wish to join them to be continuous.  To join these elements using OpenRoads 
Designer, use the Complex By Element tool, which is found on the Geometry tab of the Drawing 
workflow.  Locate the Horizontal tool group, and click on Complex Geometry > Complex By Element. 

 
Complex By Element Tool 

On the dialog that appears, you will be given a choice between Manual and Automatic for the Method 
setting.  With the Manual method, you will choose each element to be joined manually.  With the 
Automatic method, you choose the first element that you would like to have joined, and then the tool 
automatically detects/selects the remaining elements to be joined.  In either case, be very careful with 
the direction the element chain is going.  While hovering over the elements to be selected, pay close 
attention to the arrows that appear to indicate which direction the chain is going.  In this example, the 
Automatic method will be used, and the element chain is to be going upward. 
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Selecting First Element with Automatic Method 

 
All Elements Selected After Selecting First Element in Chain 

With all the desired elements in the chain selected, you can apply the appropriate feature definition to 
the complex element chain.  In this case, click on the dropdown arrow in the Feature Definition field and 
navigate to Linear > Right of Way > Proposed > RW_ExistingRW. 
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Selecting the RW_ExistingRW Feature Definition 

With the feature definition selected, you can then give the element chain an appropriate name.  Finally, 
click in the drawing to accept the creation of the complex element chain. 
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3.8 Cross Sections 

As of the release of OpenRoads Designer, cross sections are created via the use of named boundaries.  
Named boundaries for cross sections determine the extents of the sections of themselves, and you can 
also specify where you want the sections created along a selected alignment.  This section will first cover 
how to prepare your PrPlan drawing for cross section creation.  It will then cover how to create named 
boundaries for your desired cross sections, and how to cut the sheets containing them. 
 
Note: The INDOTWise 5.1 Workspace for OpenRoads Designer 2023 now has Workset functionality 
enabled.  This functionality allows for the use of the Workset Sheet Index, and sheets can be directly cut 
to the Index through OpenRoads Designer.  Please see Section 3.9 of this document for further 
information on using this functionality. 

3.8-1  Preparing PrPlan.dgn for Cross Sections 
As discussed in the previous section on changes, for the proposed corridor to display on your sections, it 
must be displayed with the proper Design Stage in the PrPlan.dgn.  To adjust the setting accordingly: 

1. Open your Prplan XX.dgn. 
2. Select the corridor model by its handle. 

 
Selecting the Corridor 

3. Examine the corridor in the Element Information panel.  Locate the Feature Definition setting. 
4. Set the Feature Definition to 9 – Final w/ Components. 

 
Feature Definitions 

5. With the setting adjusted, save your settings and check your file back into ProjectWise. 
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3.8-2  Cross Section Creation via Named Boundaries 
With your corridor model displayed using the correct feature definition, sections can now be cut via the 
Named Boundary tool—which is in the Drawing Production tab of the OpenRoads Modeling workflow. 

 
Named Boundary Tool   

With the Named Boundary tool open, perform the following steps to create your cross sections and 
resulting sheets: 

1. As a preliminary step, you will need to create a 3D model in the PrPlan drawing—which is 
necessary for creating sheets from the cross section named boundaries.  Right-click and hold in 
your current view, and then select View Control > 2 Views Plan/3D in the menu that appears.  
This will open a 3D view of your PrPlan drawing. 

 
Opening a 3D View of PrPlan 
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NOTE: If you do not open a 3D view of PrPlan prior to creating your cross section sheets, you will 
get the following warning when you try to create them—which prompts you to create the 3D 
model before sheets can be created: 

 
Sheet Creation Warning 

2. With the 3D view created, select the Civil Cross Section option in the Place Named Boundary 
dialog (fourth from the left). 

 
Civil Cross Section Option 

3. Next, select the desired drawing seed from the dropdown list.  The drawing seed in this case 
determines both the scale and the left/right offsets for the created sections.  For this example, 
the Cross Section 5 Scale drawing seed will be chosen. 

 
Selecting a Drawing Seed 
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4. In the drawing, dynamically select the alignment that you wish to cut the sections along.  The 
Name field in the Place Named Boundary dialog becomes populated with the name of the 
alignment, and a Description (if desired) can be entered as well.  The Name and Description 
fields are for the cross section named boundary group that will be created. 

 
Name and Description Fields for the Cross Section Group 

5. Next, set the start and stop locations along the alignment for which you want to cut sections.  
This can be done either dynamically in the drawing or entered in manually in the dialog. 

 
Dynamically Entering Cross Section Start and Stop Locations (50 ft interval between sections shown) 
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Start and Stop Locations Set in Dialog (Arrows clicked on right side of each field to lock to start and 

end of selected alignment, respectively) 

6. The Left and Right Offset fields are preset by the selected drawing seed, so these settings as a 
general rule do not need to be changed. 

7. Adjust the cross section interval as desired.  In this example, an interval of 50 ft will be used. 
8. The vertical exaggeration (set to 1 by default), should be acceptable in most situations. 
9. The top clearance (minimum distance between the top of the data in the section to the top of 

the cross section grid; set to 5 by default), bottom clearance (minimum distance between the 
bottom of the data in the section and the bottom of the cross section grid; set to 5 by default), 
and elevation datum spacing (interval of starting elevations on cross sections; set to 5 by 
default) should also be acceptable, but can be altered as desired. 

10. The checkboxes at the bottom of the dialog are as follows: 
• Include Control Points: If control points have been configured for the horizontal curves 

on the alignment, enabling this setting will add cross sections at the stations where the 
control points are located.  In most cases, though, this can be left disabled. 

• Backward Facing: If enabled, the cross sections would be cut as if you are facing 
backward in relation to the direction the alignment is going.  In essence, the left and 
right sides of a “normal” cross section would be reversed.  By default, all cross sections 
are cut from a forward-facing perspective. 

• Create Drawing:  When enabled, this indicates you want to proceed with creating cross 
section sheet drawings.  In this example, this setting will be enabled.  NOTE: If you wish 
to include end area volumes on your cross sections, leave this setting disabled, and 
proceed to the following section on creating end area volumes for further instructions. 

• Show Dialog:  When enabled, this setting will bring up the Create Drawing dialog once 
you are satisfied with the Named boundaries to be drawn.  In this example, the setting 
will be enabled. 
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11. Once the settings are configured as desired, click in the drawing to confirm the named boundary 
placement.  The Create Drawing dialog will then appear.  Review the settings as needed. 

12. On the Create Drawing dialog, pay special attention to the One Sheet Per Dgn setting.  This 
setting tells OpenRoads Designer to create a separate dgn file for each cross section sheet that 
gets created.  The process to follow for each scenario (with this setting disabled vs. enabled) 
going forward is explained next. 

 
One Sheet Per Dgn Setting 

One Sheet Per DGN Setting Disabled: 
13. With the One Sheet Per Dgn setting left disabled, proceed to give an appropriate name to the 

first created cross section sheet in the Model Name field in the Sheet Model section.  In this 
example, Cross Section Sheet 1 will be used as shown above. 

14. Apply the appropriate annotation group to the cross sections in the Annotation Group field.  In 
the dropdown, navigate to Cross Section > Drawing > (Annotation Scale) > (Annotation Group).  
In this case, the XSec – 5 Scale > 5 Scale_ALL ANNOTATIONS annotation group will be used. 

 
Select Annotation Group 
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15. Once all the settings in the Create Drawing dialog have been confirmed, proceed to click OK to 
create the named boundaries/cross sections.  The process may take some time if there are 
several cross sections to be created.  Shown below is an example of what is produced—with 
drawing models created for each section, and sheet models on which the drawing models are 
placed. 

 
Cross Section Sheets and Associated Drawing Models 

One Sheet Per DGN Setting Enabled: 
15. After enabling the One Sheet Per Dgn setting, click on the folder icon to select where you want 

the new sheets to be placed—which can either be inside or outside of ProjectWise.  In this 
example, they will be placed inside of ProjectWise. 

16. Select an appropriate name in the Model Name field under Sheet Model as your first sheet.  In 
this example, a simple name of Cross Section Sheet 1 is used. 

17. Apply the appropriate annotation group to the cross sections in the Annotation Group field.  In 
the dropdown, navigate to Cross Section > Drawing > (Annotation Scale) > (Annotation Group).  
In this case, the Xsec – 5  Scale > 5 Scale_ALL ANNOTATIONS annotation group will be used. 

18. Also note the Open Model setting at the bottom of the dialog.  If you do not wish to have your 
current OpenRoads Designer session ended when the sheet creation process is over, disable this 
setting.  Otherwise, the current OpenRoads Designer session will be ended, and the latest cross 
section sheet dgn to be created will be opened in its place. 

19. Once all the settings are confirmed, click OK to proceed with sheet creation. 
20. Once processed, the sheets will be created and placed at the selected location. 

 
Created Cross Section Sheets in ProjectWise 
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NOTE: When initially created, the new dgn files will be associated with MicroStation by default.  In 
order to open these new files with ORD, you will need to modify the files’ properties such that it is 
associated with ORD instead of MicroStation. 

3.8-3  End Area Volumes 
To create end area volumes for your cross sections, you must first create cross section named 
boundaries as discussed in the previous section.  As explained in the previous section, DO NOT enable 
the Create drawing setting in the Place Named Boundary dialog—leave this disabled, as you just want to 
create the named boundaries themselves at this point.  Before the cross section drawings get created, 
you need to first create the end area volume data to be placed into the cross sections.  This process is 
explained in this section. 

1.  With the named boundaries created, the first step is to create the cut fill volumes.  To do this, 
navigate to the Terrain tab in the OpenRoads Modeling workflow, and in the Analysis section 
click on Volumes > Create Cut Fill Volumes. 

 
Create Cut Fill Volumes 

2.  Data point in the drawing to accept the default settings for cut fill volumes, then data point to 
accept.  The cut fill volumes will then be calculated and created in the 3D view.  Note that red 
indicates cut volume, and blue indicates fill volume.  Also note that the outline of these meshes 
will appear in the cross sections themselves—however, these are set to not plot so as not to 
obscure other data. 

 
3D View of Cut Fill Volumes 
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3. With the cut fill volumes created, the next step is to create an end area volumes report.  This 
compiles the end area volume data for each section and populates the end area volume tables 
that will get placed on the cross section sheets.  To do this, with the OpenRoads Modeling 
workflow still active, go to the Home tab, and in the Model Analysis and Reporting section click 
on Civil Analysis > End Area Volumes Report. 

 
End Area Volumes Report 

4. In the Named Boundary Group dialog that appears, the name of your recently created named 
boundary group should automatically populate.  Data point to accept it.   

5. You will then be presented with the option to select starting and ending cross section named 
boundaries if you want to create a volume exception.  If a volume exception is desired, proceed 
to select the named boundaries in the drawing as prompted.  Otherwise, right-click to complete.  
The Bentley Civil Report Browser will then create the End Area Volume Report. 

 
End Area Volume Report in Report Browser 
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6. With the End Area Volume Report created, you can now proceed to create the cross section 
drawings.  From the Drawing Production tab, click on the icon in the bottom right corner of the 
Named Boundaries section to bring up the Named Boundaries dialog. 

 
Accessing Named Boundaries Dialog 

7. In the Named boundaries dialog, navigate to and then select the Cross Section Group you have 
created.  Proceed to click on the Show the Create Drawing Dialog button, followed by the Create 
Cross Section Drawing button. 

 
Named Boundaries Dialog 
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8. On the Create Drawing dialog, select an appropriate name for the cross section sheets in the 
Model Name field under Sheet Model, and be sure to select the appropriate annotation group. 

 
Create Drawing Dialog 

9. With the settings in place, click OK to create the cross section drawings.  Once the drawings are 
created, you will see the end area volume annotation located at the top right corner of each 
cross section grid.  

 
End Area Volume Annotation 
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3.8-4  Cutting Cross Sections of Existing Pavement to Show Existing Cross Slopes 
There may be instances where you need to cut cross sections of the existing pavement to show the 
existing cross slopes.  This section will take you through the process of creating an “alignment” from the 
existing road crown, running a corridor along it, and then create point controls for the specified corridor 
to target the existing edges of pavement—and if necessary, additional points along the pavement 
surface.  Finally, once you’ve established the corridor of your existing pavement surface, then you can 
cut cross sections that annotate the existing cross slopes. 

1. The first step of the process is to reference your survey fieldbook file (containing your existing 
terrain) into a blank 2D, geocoordinated seed file. 

2. Activate the existing terrain that you’ve referenced into the file. 
3. Select the existing road crown string from your survey and copy it in place. 

 

Copying Existing Road Crown String 
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4. Select the road crown string you just copied, and hover over it to view the heads-up display.  
Select the second option (Open Profile Model), and proceed to select the view to place the 
profile model. 

 

Open Profile Model 

5. You should now see a profile view representing the profile of your existing road crown.  Select 
the existing profile, and set it as active.  Once you’ve set the profile as active, close the profile 
model/view. 

 

Set Existing Road Crown Profile as Active 

6. Via the Corridors tab of the OpenRoads Modeling workflow, create a new corridor along your 
existing road crown “alignment”.  First, select the New Corridor tool. 

 

New Corridor Tool 

7. With the tool selected, proceed to follow the prompts to select your existing road crown as the 
corridor baseline, right-click/reset to set the profile as the active profile, and provide a name for 
the corridor.  You can also specify the feature definition/design stage for the corridor in the 
Create Corridor dialog.  In most cases, you will want to specify the 3 – Final feature 
definition/design stage—though there could be cases where a different feature 
definition/design stage could be used. 
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Creating the Corridor 

 NOTE: If your existing road crown string contains a B-spline curve element within it, you will 
receive a warning message upon selecting your road crown string as your corridor baseline.  For 
the purposes of this process, this message can be ignored. 

 

B-Spline Curve Warning Message 

8. With the corridor now created, you will be presented with the Create Template Drop dialog.  For 
the Template setting, click on the ellipsis button to select your template.  Proceed to select the 
Templates\Existing Pavement_Seek template. 
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Selecting the Existing Pavement_Seek Template 

9. With the Existing Pavement_Seek template selected, proceed through the prompts to select 
your start and end stations for the template drop (in most cases, you would enable the Lock to 
Start and Lock to End settings), and your desired template drop interval.  In most cases, an 
interval of 10 ft should suffice.  The resulting corridor will look like the following: 

 

Created Corridor with Existing Pavement_Seek Template 

Note that the corridor is very narrow—which is by design.  This is done to reduce any confusion 
about the visual cues that ORD gives when you add a point control to a template point.  This will 
become apparent later in the process. 
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10. At this point, you need to create point controls to have the left and right template points match 
their respective edges of pavement.  In the Edit section of the Corridors tab, select Edits 
dropdown > Create Point Control.  

 

Create Point Control Tool 

11. Proceed through the prompts as follows: 
• Locate Corridor: Select your corridor. 
• Start/End Stations: Lock to Start and Lock to End options should be enabled in most 

cases. 
• Control Description:  Enter a description for your point control (optional). 
• Locate Point: Select the left/right side of your corridor. 
• Mode: Select the Both option, which will direct the point control to target the respective 

existing edge of pavement both horizontally and vertically. 
• Control Type: Select the Linear Geometry option, which specifies that you are going to 

select a linear feature as the point control target. 
• Locate Plan or Profile Element: Select the left/right edge of existing pavement 

corresponding with the side of the corridor you’ve selected. 
• Priority:  Default is 1, which is fine. 
• Horizontal/Vertical Offsets:  These can be left at a value of 0.  Click to proceed through 

these settings. 
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Create Point Control Settings 

12. Upon creating point controls that target the edges of pavement, your corridor edges of 
pavement should line up with what’s existing. 
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Corridor Edges of Pavement Matching Existing 

 NOTE: You will see two white lines that represent the original location of the EOP points from the 
Existing Pavement_Seek template.  While these are construction elements that can easily be 
turned off, we made the left and right EOP points on the template with very small offsets to 
reduce any sort of visual confusion on what they’re actually representing. 
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13. With the corridor now matching the existing pavement, you can proceed to create cross 
sections as specified earlier in the chapter.  Upon applying an appropriate annotation group that 
contains cross slopes, you can observe the calculated existing cross slopes. 

 

Existing Cross Slopes Annotated on Cross Sections 

3.8-4a Adding Additional Points to the Existing Pavement_Seek Template 
There may be situations when you want the existing pavement template to seek out additional points 
along the existing pavement surface (edge of paved shoulder, edge of gravel/unpaved shoulder, etc.).  In 
order to accomplish this, you will need to add unconstrained components to the Existing 
Pavement_Seek template.  This section will give a brief step-by-step description of the process. 

1. Make a copy of our provided INDOT.ITL template library from our workspace. 
2. In the copy of the library, make a copy of the Existing Pavement_Seek template. 
3. In the copy of the template, add the necessary additional points via unconstrained components.  

In this example, components representing the shoulders are added. 

 

Existing Pavement Template with Shoulder Components/Edge of Shoulder Points 

4. Proceed through steps 6 – 13 of the previous section to create a corridor with the newly created 
template.  Then add the necessary point controls to the corridor that target the correct 
elements. 
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3.8-5  Cross Section Tips and Tricks 
When creating cross sections, there are some scenarios that may arise which require special attention 
during the cross section creation process.  This section will cover those scenarios. 

3.8-5a Excluding Individual Cross Sections 
Situations may arise where you want to exclude individual cross sections from a Named Boundary 
Group.  To accomplish this, open the Named Boundaries dialog, and expand the Cross Section Group 
that contains the cross sections you want to be excluded.  To exclude a section from a group, simply 
right-click on the section you want to exclude, and then select Delete. 

 
Excluding/Deleting Individual Cross Sections 

Once the section is excluded/deleted, proceed to create the cross sections as you would normally, and 
the deleted section will no longer appear on the cross section drawings. 

3.8-5b Cutting Individual Cross Sections Along a Skew 
Situations may arise where you need to cut individual cross sections along a skew.  This can be 
accomplished with the Civil Cross Section 2 Points option in the Place Named Boundary dialog. 

 1. Open the Place Named Boundary dialog and select the Civil Cross Section 2 Points option. 

 
Civil Cross Section 2 Points Option 
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2. Data point on the alignment to select it as the drawing path. 

3. Be sure to have the appropriate drawing seed selected, as well as the name of the cross section 
group you would like this section to be added to. 

 
Drawing Seed and Group Selection 

4. You will then be prompted to enter the two end points for the skewed section.  Proceed to 
select the two end points of the skewed section in the 2D view, and then data point to accept.  A 
new named boundary will be created, which can be seen in the 3D view.  NOTE: It will most 
likely be necessary to manually draw out the skewed section in the drawing first before creating 
its associated named boundary. 

 
Skewed Cross Section Named Boundary 
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10. To verify the station of the named boundary in relation to the selected alignment, you can go to 
the Named Boundaries dialog. 

 
Skewed Cross Section in Named Boundaries Dialog 

3.8-5c Recutting Existing Cross Sections 
If you’ve already created some cross sections that you wish to recut, you can easily do so via the Named 
Boundaries dialog.  First, make sure you have a 3D view open that contains the cross section named 
boundaries.  Then, select the Cross Section Groups section, and select your desired cross section group. 

 
Selecting Cross Section Group 
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Then with the cross section group selected, click on the Show the Create Drawing Dialog button, 
followed by the Create cross section drawing button. 

 
Create Drawing Dialog and Create Cross Section Drawing Buttons 

This will bring up the Create Drawing dialog, where you can adjust the settings for your cross sections as 
desired. 

 
Create Drawing Dialog 

Note: As previously mentioned, this process can similarly be applied to other sheet types in the Plans 
Production process.  Repeat the listed steps with the appropriate named boundary groups selected. 
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3.8-5d PG/EG Elevation 
The default annotation groups locate the PG elevation annotation based on the CL point definition in the 
applied corridor template.  In the event that the EG annotation should be used, one should go into their 
template drop and change the CL Point to EG which will then change the annotation.  Note that 
drawings will need re-annotated in order for this change to be displayed. 

3.9 Adding Cut Sheets to the Sheet Index 

As covered in the INDOTWise 5.1 MicroStation document, the INDOT Workspace for OpenRoads 
Designer 2023 now includes Workset functionality, and along with it, Sheet Indexing.  Adding this 
functionality into the mix allows for OpenRoads Designer to place cut sheets directly into the Sheet 
Index automatically. 

Note: When placing sheets directly into the Sheet Index, one may see additional check out/in 
functionality occur in the background.  This is intended as OpenRoads interacts with ProjectWise to 
automatically check out the Workset so sheets can be added to it.  Please keep in mind that there will be 
instances where the INDOT_WS.dgnws will prompt to be checked back in manually, as this portion of the 
process cannot be done automatically and does provide an opportunity to free it should unintended 
settings be enabled. 

With the Workset functionality enabled, on the bottom of the Create Drawing window for both Plan 
Profiles and Cross Sections, the Add to Sheet Index button is now able to be selected. 

 
Add to Sheet Index 

By selecting this, ORD will then place all the sheet model that it cuts directly into the Sheet Index 
without the need to manually add these sheets.  When the Add to Sheet Index option is enabled, the 
button to the right side (Select a folder from Sheet Index) will also be enabled—which allows for the 
placement of the cut sheets into a folder in the Sheet Index if so desired. 

 

Select folder from Sheet Index 
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Sheet Index Folder Picker 

When used, and all sheets cut to the Sheet Index, a configured Sheet Index could look similar to the 
following: 

 
Sample Sheet Index 
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3.10 Bringing Legacy Data into OpenRoads Designer  

It is possible to bring legacy data (i.e., civil content from SelectSeries releases) into OpenRoads Designer.  
To accomplish this, you will need the following necessary files: 

• A .dgn file containing the survey fieldbook and symbols drawn up in the SS4/10 OpenRoads 
format, this could also be provided as a pre-OpenRoads .fwd format survey file. 

• A .dgn containing the survey terrain model in the SS4/SS10 OpenRoads format, this could also 
be a .dtm file containing the terrain as modified by Survey (triangulation cleanup, etc.) 

• A ..dgn containing the survey alignment as a SS4/SS10 OpenRoads element, this could also be 
provided as an .alg file containing the horizontal survey alignment 

• Appropriately geocoordinated seed files 

For a project that was surveyed and provided to INDOT standards, the above files should already be 
available.  If you do not have these files, the following subsections will cover what steps may need to be 
done—including alternate steps to create the necessary items.  In addition to these necessary items, 
there are supplemental items that can also be brought into ORD. 

• ITL template libraries: These can be brought forward but note that they will need to be updated 
to take into account adjustments to features, naming, and targeting. 

• IRD corridor file: If available from an older SS2 project, these can also be brought forward, with 
the same caveat as the ITL template libraries. 

3.10-1  Working with Legacy Data in ORD 
As mentioned in the previous section, it is necessary to have appropriately geocoordinated seed files to 
import the legacy data into.  This section will guide you through the process of taking the 
geocoordinated seed files and referencing the legacy data into them.  If no geocoordinated seed files 
exist, alternate steps will be provided as needed. 

3.10-1a Working with the Survey Fieldbook and DTM/Terrain 
5. As outlined in section 2.2-6 of this document, import your old survey data into your 3D ORD 

Survey Fieldbook file.  This will create your survey fieldbook in ORD. 
6. Create a brand new DGN file from the 3D geocoordinated seed file provided to you.  If an 

appropriate seed file is not provided, the default 3D seed file from our workspace can be used, 
and the geocoordination can be imported directly from the survey fieldbook file.  See section 
3.4-1 for instructions on this process.   

7. In the new DGN file, attach the survey fieldbook. 

NOTE: Steps 4 through 7 below are only applicable if you were not provided a 3D geocoordinated seed 
file from Survey.  If you were provided with the seed file, disregard these steps and proceed to step 8. 
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8. If the 3D geocoordinated seed file was not provided (i.e., you are working from the default 3D 
seed file), apply the geocoordination via the Geographic Coordinate System dialog.  This can be 
accessed in various locations—shown below is the Geographic tab of the Survey workflow. 

 
Accessing Geographic Coordinate System Dialog 

9. There are two ways to apply the geocoordination from this dialog.  The first is by clicking on the 
From Library button and then selecting it from a GCS library, as shown below.  Upon making 
your selection, click OK. 

 
Selecting GCS from Library 
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10. The second way to apply geocoordination is by clicking on the From Reference button.  Select 
the referenced survey fieldbook file on the Geographic Coordinate System from Reference 
dialog, and click OK. 

 
Applying GCS from Reference 

11. Upon applying the geocoordination, you will be presented with a warning that the selected GCS 
has metric units, while the storage units in the current model are US Survey Feet.  Select the 
first option to keep the storage units in US Survey Feet.  Then click OK to proceed. 

 
GCS Storage Units Warning 

12. The next step of the process is to import the terrain from the Survey-provided DTM.  To do this, 
go to the OpenRoads Modeling workflow, and on the Create tool group of the Terrain tab, select 
the From File option. 

 
Creating Terrain from File 
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9. Select the Survey-provided DTM on the Select Files to Import dialog and click OK. 

 
Selecting File to Import 

10. You will then be presented with the Import Terrain Model(s) dialog.  The settings you need to be 
concerned with are in the File Options section of the dialog: 

• Feature Definition: Specifies your desired feature definition for the terrain you are 
importing.  There are several possible options for this—in the case of this example, 
Existing_Contours_5 : 1.0 is selected from the list. 

• Source File Units: Specifies the units of the source file, which in this case is US Survey 
Feet. 

• Import Options: Specifies what components from the DTM that you would like to 
import.  There are three options.  Import Terrain Only will only have the terrain 
component of the DTM imported into the file.  Import Features Only will only have the 
survey features contained in the DTM imported into the file.  Import Both will import 
both the terrain and the survey features into the file.  In this example, we only want the 
terrain, so Import Terrain Only will be selected. 
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• Source: Used to specify the source of geocoordination for the terrain.  We already have 
the geocoordination specified, so this setting can be left at None. 

 
Importing Terrain Model from DTM 

11. With your desired options selected, click Import to proceed with the terrain import. 

NOTE: If you choose the Import Features Only option when importing the terrain model, be 
advised that all of the survey features found in the DTM will be placed on the Default level and 
lose their featurization.  This issue has been filed with Bentley by CAD Support as an Enhancement 
Request.  To address this scenario, you have two options.  You can either manually featurize them 
after the import, or you can copy the features as line strings and featurize them from there. 
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3.10-1b Working with the ALG/Alignment 
12. With the terrain now imported, the next step is to create a brand new 2D file from a seed file to 

bring in our ALG data (alignment).  The easiest way to do this is to click on the File tab to open 
the Backstage view in ORD, and then click on New. 

  

 
Creating a New File in ORD 

13. Select No Wizard at the next prompt and click OK. 
14. Then on the next dialog, specify a destination folder for the new file, an appropriate name and 

description for the new file, the application to be associated with the new file (which in this case 
is OpenRoads Designer), and finally, the INDOT_US_SVFT_2D seed.dgn file from Template 
Documents as the Source Document (chosen by clicking on the Seed… button). 

 
Settings for New 2D File 

15. You will then be prompted to check in the file you’ve been working on up to this point, proceed 
to do so. 

16. With the new 2D DGN file open, proceed to attach the 3D file with the survey and terrain as a 
reference.  Note: Considering that the 3D file you created has a reference itself, you will need to 

pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5CORD-Connect%20Seed%5CINDOT_US_SVFT_2Dseed.dgn
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5C
pw:%5C%5Cindot-pw.bentley.com:indot-pw-01%5CDocuments%5CTemplate%20Documents%5C
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set the Nesting Depth setting in the Reference Attachment Properties to a value of 1 so that you 
can see all of the content. 

 
Attaching Survey and Terrain as a Reference with Nesting Depth of 1 

17. With the terrain now attached to the file, proceed to make it active.  This will create a 3D model 
in the file. 

18. You are now ready to import the geometry from an ALG file.  With the 2D model open, go to the 
OpenRoads Modeling workflow if not already open and on the Home tab select the Import 
Geometry tool from the Model Import/Export tool group. 

 
Import Geometry Tool 
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19. Select the desired ALG file from its location in ProjectWise and click Open. 
20. You will then be prompted to select the various components of the ALG that you would like to 

import.  In most cases, it should be acceptable to select all of the components. 

 
Selecting ALG Components to Import 

21. At the bottom of this dialog are two very important settings: 
• Assign Feature Definition  Linear Features: For the alignment feature (linear feature), set 

the appropriate feature definition from the dropdown list.  In this example, the Alignment > 
P_ALG_Horizontal under 50 Scale feature definition is chosen. 

• Create Civil Rules: Creates all of the necessary civil rules for your imported alignment.  It is 
strongly recommended that this setting always be enabled. 

22. With the import settings set as desired, click Import to import the ALG/alignment. 
23. With the alignment imported, perform steps 4 through 7 in this file to apply geocoordination. 
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4. Drawing/Sheet Annotation in OpenRoads Designer 
Upon creating your plan sheets per the processes discussed in the previous chapter, several annotations 
need to be added to convey the necessary information on them.  This chapter covers the processes for 
creating these annotations in OpenRoads Designer using the following three methods: Drawing Model 
Annotation, Element Annotation, and the Civil Labeler tool. 

Note: OpenRoads Designer is heavily leveraging the use of Drawing models as an intermediate container 
between the design and sheet models.  Unless otherwise specified, all annotations should now be placed 
on the content in the drawing models.  This is necessary for the more advanced annotation tools that 
read, report, and annotate information directly from the civil content.  Using the drawing models plus 
the appropriate drawing scales and a combination of the below listed tools and other text and dimension 
placement tools should provide a flexible process for adding appropriate annotations. 

Note: Any linear annotations (horizontal alignments and vertical profiles) have had new settings applied 
that should allow for their annotation text to be moved and retain their placement if the element is re-
annotated.  This applies to any files created after 2/19/24 in both the ORD 21r2 and ORD 23r1 
workspaces.  For information on how to update and apply this change to existing files, please see section 
4.5 in the INDOTWise Technotes document. 

4.1 Drawing Model Annotations 

The Drawing Model Annotation tool in ORD allows you to add annotations to either an individual, or all 
drawing models in a design file.  The tool can be found on the Drawing Production tab in either the 
OpenRoads Modeling or OpenRoads Drawing Production workflows, as shown below. 

 
Drawing Model Annotation Tool 

The remainder of this section will cover how to use the Drawing Model Annotation tool to apply 
annotations to various design elements in the drawing models of your plan sheets. 
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4.1-1  Plan View Annotations 
As specified in the previous chapter, the drawing model annotation should already be applied at sheet 
creation time when selecting an annotation group for the plan view of a plan sheet.  If not already 
applied, you can use the Drawing Model Annotation tool to add this annotation—which only consists of 
the north arrow, and a border representing the plan view border extents for use when applying 
annotation of survey features. 

To add the annotation, have the drawing model of the plan view open, and select the Drawing Model 
Annotation tool to bring up the Annotate Drawing Model dialog: 

 
Annotate Drawing Model Dialog 

Then to add the annotation, select the ellipsis button, which will present a dialog where you can select 
the appropriate annotation group for your situation.  For example, for a 30 scale plan view on a plan and 
profile sheet, you would select Plan > Drawing > Plan Profile 30 Scale. 

 
Selecting Plan Annotation Group 

If you would also want to apply this annotation to all drawing models in the file, you can select the 
checkbox for All Drawing Models.  Then to apply the annotation, click once to confirm the All Drawing 
Models setting, and then once more to confirm your selection of annotation group to apply to the 
drawing model(s).  The annotation will then be applied to the drawing model(s), as denoted by the 
arrows in the screen capture below: 
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Drawing Model Annotation Applied to Plan View 

4.1-2  Profile View Annotations 
As currently configured, there are no annotations that need to be added to a profile view of a plan sheet 
via the Drawing Model Annotation tool.  Such annotations are covered by either the Element Annotation 
tool or the Civil Labeler tool, which are discussed later. 

4.1-3  Cross Section Annotations 
To add annotations to a drawing model of a cross section, click on the Drawing Model Annotation tool.  
Click on the ellipsis button in the dialog, navigate to Cross Section > Drawing and note the following 
layout has been created for cross section annotation groups. 

 
Cross Section Annotation Group Layout 

The available cross section annotation groups have been broken down first by scale, and then the 
individual annotations for each scale. 
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4.1-3a Breakout Drawing Annotations 
As shown in the previous screen capture, there are six available annotation groups for each scale: 

• ALL ANNOTATIONS: Contains all the available annotations. 
• Cross Slopes: Only contains the cross slopes for the relevant design elements. 
• Crossing Features: Only contains the annotation of various crossing/survey features that are 

commonly encountered (utilities, R/W, guardrail, etc.). 
• EAV table: Only contains the end area volumes table to be placed at the top right corner of each 

section.  See the subsection below for information on how to append the benching volumes to 
this table. 

• Grid Only: Only contains the cross section grid. 
• PG/EG Elevation: Only contains the PG or EG annotation (with leader) for each section. 

4.1-3b Benching Table Placement 
To append benching annotation to the EAV table on the cross sections, you will need to do so via placing 
it as a cell in your drawing model.  You will be able to do this via the Benching Table Cell tool, located in 
the Drawing Production tab of either the OpenRoads Modeling or OpenRoads Drawing Production 
workflows, OR the Annotation Tools tab of the INDOT Tools workflow. 

 

 

 
Benching Table Cell Tool Locations 
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Clicking on the tool automatically opens the Place Active Cell dialog with the global EAV_BENCH cell 
already selected.  Then simply place the cell at the bottom left corner of the existing EAV table cell. 

 
Placing Benching Table Cell 

To edit the values, simply double click to start the text editor and replace the provided template values.  
Note that this table element will not be removed as part of the drawing model annotation. 

4.1-4  Removing Drawing Model Annotations 
Removing drawing model annotations is a simple process.  However, be very careful in using this 
functionality, as it removes ALL drawing model annotations in a model/drawing.  There is no option 
for removing individual drawing annotations. 

To remove drawing model annotations, click on the Drawing Model Annotation dropdown and select 
the Remove Drawing Model Annotations option. 

 
Remove Drawing Model Annotations 

You will then be presented with a dialog providing a single option, which is to apply the annotation 
removal for all the drawing model annotations from all the drawing models in the file.  With your 
desired option selected, a single left click in the view will remove all drawing annotations. 

 
Remove Drawing Model Annotations 
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4.2 Element Annotations 

The Element Annotation tool in ORD allows you to add annotations to individual design elements.  The 
tool can be found on the Drawing Production tab in either the OpenRoads Modeling or OpenRoads 
Drawing Production workflows, as shown below. 

 
Element Annotation Tool 

This section will cover the annotations applied with this tool.  For the purposes of the plan production 
process, you will solely focus on annotating the horizontal and vertical alignment elements. 

  

4.2-1  Annotating Horizontal Alignments 
To annotate a horizontal alignment, be sure to first have a drawing model with a plan view opened.  
Then select the Element Annotation tool to open the Annotate Element dialog: 

 
Annotate Element Dialog 

Note the settings in this dialog: 

• All Elements in Model: Enable this setting to annotate all the elements in the model with the 
same annotation group. 

• All Drawing Models: Enable this setting to apply the annotation group to all the drawing models 
in the file that contain the selected element. 

• Override Annotation Group: Enable this setting to override any existing annotation groups that 
are being applied to a selected element. 

• Annotation Group: The annotation group that you wish to be applied to a selected element. 

Note: If the Override Annotation Group option is unchecked/disabled, the Annotation Group setting will 
not be displayed.  In this scenario, the default annotation group associated with the feature symbology 
of the selected element would be applied.  If no default annotation group exists for the selected element, 
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no annotation will be applied—and the protocol would then be to check/enable the Override Annotation 
Group setting and select the appropriate annotation group to be applied. 

Note: When using the Annotate Element tool, usage throughout this document covers using this tool 
with the All Elements in Model selection unchecked.  The current workflow is to allow the end user to 
apply their annotation to specific elements on an as-needed basis and allows for flexibility when they are 
necessary.  If the All Elements in Model option is checked, OpenRoads Designer will interrogate every 
element visible in the current drawing model (and potentially all associated drawing models in the active 
DGN if All Drawing Models is selected), and annotate them according to whatever annotation groups are 
applied to the assigned feature symbology.  This could cause a number of unwanted or unneeded 
annotations to be placed and should rarely be used in the current workflow. 

For the purposes of this example, you will have a created horizontal alignment that does NOT have an 
annotation group assigned to it via its feature symbology.  This would thus necessitate the enabling of 
the Override Annotation Group setting and the selection of an annotation group.  With the Override 
Annotation Group setting enabled, click on the ellipsis button in the Annotation Group field to select the 
desired annotation group.  In this example, you are working with a 30 scale plan view, so select the Plan 
> Linear > Stationing Under 50 Scale annotation group. 

 
Selecting Annotation Group for Horizontal Alignment 

With the annotation group selected, left click in the drawing to accept the current settings (leaving the 
other settings disabled).  You will then be prompted to select the elements to annotate.  Proceed to 
select your alignment(s) and then right click to accept.  The desired annotation will then be applied to 
the alignment.  Note that the selected annotation group includes station labels, tangent bearings, PC/PT 
stations, curve data, etc. 
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Applied Element Annotation to Horizontal Alignment 

4.2-2  Annotating Vertical Alignments 
In much the same way as for horizontal alignments, vertical alignments can also be annotated via the 
Element Annotation tool.  To accomplish this, open a drawing model containing a profile view and select 
the Element Annotation tool.  With the first two settings in the dialog disabled, and the Override 
Annotation Group setting enabled, click on the ellipsis button in the Annotation Group field to select an 
annotation group to apply to the vertical alignment.  In this case, select the Profile > Linear > Alignment 
Profile annotation group. 

 
Selecting Annotation Group for Vertical Alignment 
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Upon selecting the desired annotation group, you will be prompted to left click twice to confirm the 
current settings and then to select the vertical alignment(s) you wish to annotate.  Right-click to accept 
the selected alignments and the desired annotation will then be applied.  Note that the selected 
annotation group includes proposed elevation labels, vertical curve data, PVC/PVT points, vertical 
tangent grades, etc. 

 
Applied Annotations to Vertical Alignment 

If additional vertical alignment annotations are needed, the process can be repeated accordingly. 

4.2-3  Removing Element Annotations 
Removing element annotations is a very similar process to removing drawing model annotations.  Unlike 
the removal of drawing model annotations, you have the flexibility to be more specific in removing 
annotations for specific elements.   

To remove drawing model annotations, click on the Element Annotation dropdown and select the 
Remove Element Annotations option. 

 
Remove Element Annotations 
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You will then be presented with a dialog that presents you with two options initially: All Elements in 
Model and All Drawing Models. 

 
Remove Element Annotation Options 

The All Elements in Model option allows you to remove the element annotations for all elements in the 
model.  When this option is selected, a secondary option for including references in the annotation 
removal is also provided.  The final option is to remove all element annotations in all drawing models in 
the file.  With your desired options selected, proceed through the prompts to select the desired 
elements you wish to remove annotation from and right-click/reset to complete the process. 

4.3 Civil Labeler 

New to OpenRoads Designer is a tool called Civil Labeler—which allows for customizable labels to be 
created and applied for annotation purposes.  There are several potential uses for this tool, and what 
will be described in this section is likely just scratching the surface of what may be possible and useful as 
we continue to learn more about its usage.  This section will cover how to access and navigate the tool, 
and then will cover how to use it to apply annotation to your drawings. 

4.3-1  Introduction to Civil Labeler 
The Civil Labeler tool can be found in the Drawing Production tab in either the OpenRoads Modeling or 
OpenRoads Drawing Production workflows, as shown below: 

 
Civil Labeler Tool 
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Upon opening the Civil Labeler Tool, you will be presented with a dialog with only a Civil Labels folder.  
Expanding the folder will present the following categories/subfolders: 

 
Civil Label Categories 

• INDOT Cross Section Labels: Labels for annotating various points in cross sections—mainly for 
points pertaining to structures and hydraulics. 

• INDOT Plan – Survey Labels: Labels for annotating various survey features in a plan view. 
• INDOT Plan Labels: Labels for annotating various points in a plan view (e.g., Begin/end of 

project, Begin/end of incidental construction, station-offset of points, etc.). 
• INDOT Profile Labels: Labels for annotating various points in a profile view (e.g., begin/end of 

project, station-elevation of points, etc.). 
• xBentley: Default labels that Bentley has provided with OpenRoads Designer.  While we believe 

we have covered at least most of the labels that you might need, you are more than welcome to 
investigate these labels and experiment with them as needed. 
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4.3-2  Plan Civil Labels 
This section will cover the civil labels that can be placed in a plan view of a drawing.  We have broken 
these labels up into two separate categories: INDOT Plan Labels and INDOT Plan – Survey Labels. 

For discussion on the format/creation of civil labels, please see the INDOTWise 5.1 Technotes document, 
OpenRoads section.  This covers the various options when creating/customizing these labels outside the 
provided default labels. 

4.3-2a INDOT Plan Labels 
The INDOT Plan Labels category contains labels for annotating general reference points along an 
alignment, such as begin/end project, begin/end incidental construction, and station-offset of right-of-
way points.  Note that each of the labels come in pairs—one that provides for even stationing, and the 
other for a standard stationing accuracy of two decimal places. 

 
INDOT Plan Labels 

 
Plan – Project End_Even Station Civil Label 
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4.3-2b INDOT Plan – Survey Labels 
The INDOT Plan – Survey Labels category contains labels for annotating survey features along an 
alignment.  These labels are the equivalent of the station-offset annotation of survey features created in 
MicroStation/InRoads SS10 and then placed along the top and bottom of the plan view.   

 
INDOT Plan – Survey Labels 

Before placing these survey labels, there is one prerequisite process that must be done first—and that is 
to attach an item type to the survey features in your survey fieldbook file.  This process is explained in 
the next section. 

Attaching Item Types to Survey Features 
Due to a known defect in ORD 2023 that strips away the survey feature definitions and descriptions 
from referenced survey fieldbooks, CAD Support has had to develop an alternative process to bring forth 
the survey feature description information into a design file—as this is required information for our 
survey civil labels.  The process entails the attachment of an item type to each survey feature in the 
survey fieldbook file such that it stores the survey feature descriptions in an alternative way.  The 
concept of item types is a very extensive topic that CAD Support is only scratching the surface on at this 
time, but for now, consider an item type in ORD as a method to attach supplemental information to 
your CAD elements.  Much more implementation and explanation of item type functionality will be 
provided in future releases of our ORD workspace.  What follows is the process for attaching our 
configured INDOT Survey Feature item type to your survey features. 

1. Open your survey fieldbook file in ORD. 
2. Using the Element Selection tool with whichever method you choose, select ALL of the survey 

features in your fieldbook file. 

 
Selected Survey Features 
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3. With all of the survey features selected, in the Utilities tab of the OpenRoads Modeling 
workflow, select the Attach Item tool. 

Attach Item Tool Location 

4. The Attach Item menu will appear.  Select the checkbox for INDOT Survey Feature Definitions to 
have that item type attached to the survey features. 

 
Selecting the INDOT Survey Feature Definitions Item Type 

5. With the item type selected in the menu, simply click anywhere within the model to proceed 
with attaching the item type to the survey features.  Note that this may take a little time to 
process depending on the size of the surveyed area and the number of features associated with 
it.  Once completed, all of the survey features within the fieldbook will have the INDOT Survey 
Feature item type associated with it. 
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Item Type Attached to Survey Feature 

With the INDOT Survey Feature item type attached to each survey feature, you can now proceed to 
attach the survey-related civil labels to the drawing models in your design files.  These labels pull the 
Feature Description information from the INDOT Survey Feature item type that is now burned into the 
referenced survey fieldbook. 

Survey Feature – Station Offset Label 
Note that prior to the process being described below, it is assumed that you a) have already created the 
plan sheets that these annotations will go on, and b) you are in a drawing model of a plan view of one of 
these sheets. 

1.    In your drawing model, open the Element Selection tool if not opened already. 

2. On the Element Selection tool, select the Levels tab—as you will select the survey features you 
wish to annotate by level. 
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Levels Tab on Element Selection Tool 

3. On the Levels tab, proceed to select the levels of the survey features you want to annotate.  In 
this example, we will select the S_TOPO_Tree deciduous and S_UTIL_Ug-gas levels. 

 
Selected Levels in Element Selection 

NOTE: In the event that no elements are actually selected when you select their associated levels in 
the Element Selection tool, please refer to section 4.4 of the Technotes section of our DOTWise manual 
for instructions on how to resolve this issue. 
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4. With your desired survey features selected, navigate to the Element Type tab in the Element 
Selection tool.  Note the Cell and the Line String element types are currently selected. 

 
Element Type Tab in Element Selection Tool 

7. On the Element Type tab, click on the Line String element type (denoted with the blue 
background, NOT the gray one) to deselect it.  This prevents the Civil Labeler from labeling any 
line strings associated with linear survey features—which in this case, is a gas line.  The way we 
have the civil label currently configured, each of the individual points along the linear feature 
will be annotated.  Note that if you are not annotating any linear features (i.e., solely point 
features), then you can skip this step. 



 225 

 
Element Type Tab with Line String Element Type Deselected 

8. With your survey features now selected, open the Civil Labeler tool from the Drawing 
Production tab. 

 
Civil Labeler Tool 
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9. In the Civil Labeler Tool, go to Civil Labels > INDOT Plan – Survey Labels > Survey Feature – 
Station Offset Label. 

 
Survey Feature – Station Offset Label 

10. With your survey features still selected, click on the Place button. 
11. You will first be prompted to identify the baseline alignment—proceed to do so.  NOTE: You will 

not be able to right-click to locate the actual alignment if there are multiple elements coincident 
with it—as it will cancel the operation.  It is thus suggested to turn off any conflicting levels so 
that you can easily select the alignment. 

 
Selecting Baseline Alignment 
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12. You will then be prompted to accept the point(s).  Left click once to accept the current selection; 
note that the labels will now appear, ready to be placed. 

 
Accept Points 

13. You will then be prompted to confirm the label placement.  Left click once again in the same 
location to place the labels in the drawing.  Depending on how many survey features are being 
annotated, it may take a bit of time to process. 

Station Offset Label Cleanup 
Due to how the file federation workflow works within OpenRoads Designer, the survey fieldbook file is 
referenced into the drawing model twice—once from the Default model of the alignment file, and the 
other from the Default-3D model of the alignment file (created via activating the terrain in the Default 
model of the alignment file).  See below for an illustration of the reference hierarchy in this scenario and 
notice the duplicate references of the Survey Fieldbook file. 

 

Duplicate References of Survey Fieldbook File 
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As a result of this scenario, civil labels created from survey features will be duplicated—as there are 
duplicate survey features in the drawing model.  See the example below of a coniferous tree survey 
feature being selected, and the resulting duplicated civil label that is created. 

 

Duplicated Survey Feature 

 

Duplicated Civil Label of Survey Feature 
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This situation can be addressed in one of two ways.  First, it can simply be ignored—and if you have to 
manually move individual civil labels, you can simply delete the duplicated civil label at that point.  
Second, if you wish to resolve this situation before you actually create the civil labels, you can go into 
the References dialog of the drawing model and turn off the display of one of the instances of the 
Survey Fieldbook reference. 

 

Turning off Display of Duplicated Survey Fieldbook Reference 

Then once the display of the duplicate Survey Fieldbook reference is turned off, you can proceed to 
create civil labels that will not be duplicated. 

With your civil label annotations placed in the drawing model, you are now ready to align them to the 
top and bottom of the plan view border.  For this example, we will start with the labels to align to the 
top of the border, and then the ones that align to the bottom. 

6. The first step will be to select all the labels corresponding with points/features to the left of the 
alignment. 

7. With the labels selected, select the Align Elements by Edge tool, which can be found on the 
Manipulate section of the Drawing tab in various workflows.  You will likely need to click on the 
dropdown arrow on the bottom right corner of the section to access the tool. 

 
Align Elements by Edge Tool 

8. On the Align Edges dialog that appears, set the Align setting to Top. 
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Align Edges Tool – Set Label Alignment to Top 

9. You will be prompted to select a base element for alignment.  Select the yellow border 
representing the plan view extents for the sheet. 

 
Select Plan View Border 

10. With the plan view border selected you will be given a preview of the realignment of the labels.  
Once you are satisfied, left click to accept the realignment.  The labels will then be aligned to the 
top of the border. 
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Aligned Labels to Top of Plan View Border 

6. Repeat steps 1 through 5 to align the labels for the features to the right of the alignment to the 
bottom of the border.  The only differences would be to select the labels to the right of the 
alignment, and then to set the Align setting in the Align Edges tool to Bottom instead of Top. 

7. As necessary, you can manually move individual labels around so that they can all be clearly 
seen. 

Survey Feature (Bulk) – Survey Note Label 
The purpose of the Survey Feature (Bulk) – Survey Note Label is to annotate several survey features at 
once with just their feature description.  The process for placing these labels is virtually the same as for 
the Station Offset Label.  The only real difference is that in this case, you do not need to select a baseline 
alignment to place the labels.  All you would need to do is have the features selected and then use the 
Civil Labeler tool to place the labels. 

Survey Feature (Individual) – Survey Note Label 
The purpose of the Survey Feature (Individual) – Survey Note Label is the same as for the bulk version, 
but just for one-off/individual usage.  Note that there is a leader associated with the label for the 
Individual version, whereas for the Bulk version there is not. 

NOTE: As it pertains to the survey feature labels, keep in mind that not all survey features have a 
note/description that is associated with them.  As such, users should investigate the survey elements 
they wish to label to be sure they have a note associated with them.  Hovering over a survey element 
should show whether it contains a note/description. 
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4.3-3  Profile Civil Labels 
This section will cover the civil labels that can be placed in a profile view of a drawing.  In its current 
form, we have labels configured for begin/end of project and for design information such as the slope 
for the tangent sections of the profile, and station and elevation of individual points along the profile 
(PVC/PVT, begin/end of ditches, etc.).  Note that for the profile labels that contain stationing, we have 
provided options for even stationing and standard two decimal accuracy. 

 
Profile Civil Labels 

The remainder of this section will provide a general overview of how to place these labels.  Note that 
prior to placing these labels, it is assumed that you a) have already created the plan sheets that these 
annotations will go on, and b) you are in a drawing model of a profile view of one of these sheets. 

4.3-3a Begin/End Project Labels 
To add Begin/End Project labels to the mainline profile, perform the following steps: 

Open the Civil Labeler Tool and navigate to Civil Labels > INDOT Profile Labels and select one of the 
Begin or End project options. 

 
Profile – Begin (or End) Project Label 

1. Click the Place button in the Civil Labeler Tool. 
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2. You will be asked to identify the baseline alignment—which in this example is the mainline 
profile. 

 
Selecting Baseline Alignment 

3. You will then be asked to select a point on the baseline alignment to place the Begin/End Project 
Label.  Proceed to select the desired point on your profile. 

4. Once the desired point is selected, the placeholder for the label will appear, and will allow you 
to place it as desired in conjunction with a leader.  When you are satisfied with the location of 
the label, left click to accept the placement. 

 
Begin Project Label 
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4.3-3b Labeling Design Information on Profiles 
There are various aspects of a profile design that can be annotated with a civil label.  For the purposes of 
this document, we will cover two use cases: Profile – Station Elevation and Profile Slope. 

Profile – Station Elevation Labels 
The Profile-Station Elevation label can be used to annotate the station and elevation of any desired point 
on a profile.  Note that we also have a companion Profile – Station Elevation – Even Stations label for use 
when the station of the point you wish to annotate is on an even station—whereas the other label has 
two decimal places for the stationing.  The following example will show how to annotate the station and 
elevation of a point on a secondary ditch profile. 

1. Open the Civil Labeler Tool and navigate to Civil Labels > INDOT Profile Labels > Profile – Station 
Elevation. 

 
Profile – Station Elevation Label 

2. Click the Place button in the Civil Labeler Tool. 
3. You will be asked to identify a baseline profile, which in this case will be a ditch profile. 

 
Selecting Baseline Profile 
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4. You will then be asked to select a point on the baseline profile you wish to annotate.  Proceed to 
select the point. 

5. Once the desired point is selected, the placeholder for the label will appear, and will allow you 
to place it as desired in conjunction with a leader.  When you are satisfied with the location of 
the label, left click to accept the placement. 

 
Profile – Station Elevation Label 

4.3-4  Cross Section Civil Labels 
This section will cover the civil labels that can be placed on cross section sheets.  As it stands at the 
present time, we have civil labels configured for annotating various structure-related points (Bottom 
Structure, Top Structure, Invert, etc.), as well as hydraulics-related points (flowline).  Future labels will 
likely be created per user request and feedback. 

 
Cross Section Civil Labels 

The remainder of this section will cover how to place a civil label in a cross section drawing model.  Note 
that prior to placing these labels, it is assumed that you a) have already created the cross section sheets 
that these annotations will go on, and b) you are in a drawing model of one of these cross sections. 

In the following example, we will place a standard offset-elevation label at a ditch bottom point. 
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1. With the cross section drawing model open, open the Civil Labeler Tool and navigate to Civil 
Labels > INDOT Cross Section Labels > Offset Elevation. 

 
Offset Elevation Civil Label 

2. Click the Place button to begin the placement of the label. 
3. You will first be asked to select an offset element.  In this case, you will select the ditch bottom 

point. 

 
Selecting Ditch Bottom Point 

4. A preview of the label will appear and will allow you to move it to a desired location.  Once you 
find a desired location for the label, data point/left-click to accept. 

 
Placed Offset Elevation Civil Label 
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4.3-5  Known Issues with Civil Labeler 
CAD Support is currently aware of a few issues that users may encounter when placing civil labels.  This 
section will cover these issues and—when applicable—how to address them. 

4.3-5a Detached Frame from Leader 
There may be times when the text frame of the civil label becomes detached from the leader.  See 
example below. 

 
Detached Frame from Leader 

One known example of when this can occur is using civil labels on cross sections where the text is placed 
to the left of the leader (as shown above).  To fix this, simply select the text frame of the label and drag 
it slightly to a new location—which will snap the leader into the proper place. 

 
Reattached Frame to Leader 

  



 238 

4.3-5b Shifting Leader when Placing Label to the Left 
Before confirming the placement of a label to the left, the reference point of placement of the text 
frame is on the left side of the placeholder text as denoted with an “X” in the screen capture below. 

 
Label Preview Before Confirming Placement 

However, upon confirming the reference point to place the label, the text frame adjusts its length to fit 
the actual length of the text it contains.  In so doing, the leader ends up shifting over to the left to make 
up for this length adjustment.  See the example below with the same label once its placement was 
confirmed.  The “X” shown is in the exact same location as shown in the previous screen capture. 

 

Label After Confirming Placement 

Note how the leader component of the label has shifted over to the left upon confirming the label 
placement.  This is not desired behavior, and CAD Support has made Bentley aware of the issue. 
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4.3-5c Placeholder Label Showing Incorrect Orientation 
When a placing a label just slightly to the left, the placeholder label that appears will display an 
inaccurate orientation.  However, once placement is confirmed, the label text and leader should correct 
themselves automatically.  See below for a before and after example scenario. 

  
Before and After Confirming Placement of Civil Label 

4.4 The Place Note Tool  

For a number of annotations, the usage of the previously mentioned tools may not be necessary.  For 
these processes, a number of legacy Place Note options can be found on the Annotation Tools tab in the 
INDOT Tools workflow: 

 

The benefit of these tools is that they are pre-configured to place the notes on the appropriate level and 
with the correct dimension and text styles.  Please note that these are legacy tools and if they need 
updated, INDOT CAD Support should be contacted to make appropriate adjustments. 
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Note:  There is currently an outstanding bug with the Place Note tool.  If you do not use the pre-
configured notes referenced above and instead use the Place Note tool directly, you will experience an 
issue where selecting your dimension style does not set the appropriate associated text style.  To 
alleviate this issue, the appropriate text style must be manually selected from the Text Editor as shown 
below: 

 

Make sure that when switching between dimension styles while using Place Note, you’re always ensuring 
that the correct text style is also selected.  This issue only affects the Place Note tool, and not the other 
Dimension tools.  Those tools correctly apply the text style defined in the dimension style. 
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